Verifone C-Site Management

User Guide

verifone




Verifone C-Site Management User Guide

Verifone®, Inc.

2744 North University Drive
Coral Springs, FL 33065
Telephone: 800-837-4366
http://www.verifone.com

Printed in the United States of America.
© 2025 Verifone, Inc. All rights reserved.

No part of this publication covered by the copyrights herein may be reproduced or copied in any form or by any
means - graphic, electronic, or mechanical, including photocopying, taping, or information storage and retrieval
systems - without written permission of the publisher.

The content of this document is subject to change without notice. The information contained herein does not
represent a commitment on the part of Verifone. All features and specifications are subject to change without
notice.



Revision History

Date

04/13/2021
10/18/2021

03/28/2022

04/12/2022

07/15/2022

02/28/2023

04/17/2023

04/27/2023
06/30/2023
07/14/2023

08/21/2023
09/11/2023
10/4/2023

11/15/2023

Description

Initial Release.

Added One-Time Password (OTP) chapter, and updated the Introduction to include the OTP,
Connect Device to Cloud, and Reports information, as well as updating the appropriate site
controller release information to 53.20+.

Updates to the Reports chapter:
Changed screenshot to show active Download Report button.
Added info on Download Report

Added TLog Viewer feature.

Updated the Introduction section to add the applicable Reports information, and the most current
software release.

Edited to conform to newest branding guidelines.

Added a table with search/report criteria to the Site Assets section of the Reports chapter, as well as
a screenshot of a sample Site Assets report.

Updated the Connect Device to Cloud section to reflect Ul updates. Changed front matter to reflect
new branding guidelines.

Updated to include Bulk Site Upload and Mobile Payment Configuration. Updated My Accounts,
Reports > Summary, and Connect Device to Cloud sections. Added additional permissions into the
Roles section.

Reviewed and updated Ul changes throughout document, Download Report for T-Log added, MID
Bulk Upload feature added, Acknowledgment Added, User Table added.

Added C-Site Requirement notice.
Added Loyalty Configuration.

Added Site Configuration Section: MOP, Currencies, Fees, Tax Rates, Categories, Departments, Blue
Laws, ID Checks

Updated Branding for C-Site and Documentation
Added Sign up process information.

Added Website URL, DNS requirement for Onboarding, new onboarding process, added Appendix |
details for Onboarding Requirements, Fuel Tax Exemption, and POS Security levels.

T-Log Viewer Type on Search is Financial by default, Note added for software support error
messaging added to Site Configuration forms, Automatic Site Creation Note added



02/09/2024

03/25/2024

06/03/2024
06/07/2024
12/18/2024

03/14/2025

04/23/2025

Added PLU Configuration, Sales Configuration, Login/Logout Message, Fuel Pricing, and Fuel Config
— In Effect, Version support notification messaging, Added additional information about account
onboarding.

Updated software ‘base’ reference to ‘release’, Added instructions on how to create an additional
Petro Site Administrator, Updated Site Asset Data to include new columns for Site ID and Location
ID, Updated Instructions on how to access Loyalty Enterprise Configuration and Mobile Enterprise
Configurations and any associated instructions

Added additional host route for C-Site VIC to 54.02 LAN Configuration table.
Replicate Configuration details added

Added Caloric Values, DCR Configuration, Payment Configuration, Administration Menu Updates to
the Site Level. Added Payment Configuration to the Enterprise Level.

Added Menu Configuration (Read Only) and Touch Screen Configuration. The EULA (Terms and
Conditions) was updated within Verifone C-Site Management.

Added Verifone Commander Password Management section, Updated Replicate Configuration
screenshots, Added Tipping section.



Verifone C-Site Management User Guide

Contents
TIntroduction. ..ot i i it it it it it 1
System Requirements ........... 2
Software Requirements ......... ... . . 2
Software Release Specific Implementation ........................... 2
Version Support Notification............ ... ... . ... . . 3
Hardware Requirements. . ....... ... . i i 3
ACCOUNt SIgN U, .ottt e e 3
Terms and Conditions . .. ... e e 5
Website URL . ... o e 6
2HierarChy ...t i i i i e i et i e, 7
View HierarChy ... 7
Edit Hierarchy . ... ..o o 8
SaAICN . . o e 10
201 =AU 11
Required Site Information ........ ... .. . Lh
View HierarChy . ... . 1
Bulk Site Creation. . ... e 12
Downloadingthe Template ......... .. i, 12
Bulk Upload Report. . ..o e 16
Bulk Upload REPOIt Errors. . ..o i 16
Manual Site Creation. . ... ... . i 18
Adding Custom Attributes. ....... ... i 20
Editing Existing Sites ... 21
L o Vo] =Y AP 23
Adding UserROIES . .. ..o 24
BCreate Users. .....coiiiiiiiiii ittt it ittt ine i 27
Deleting alUser. ... e e e e 27
Creating an Additional Administrator Account............................ 28
6Dashboard. ... i i i i et e i 29
Dashboard on Initial Login. ... 30

-
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. i



Verifone C-Site Management User Guide

My ACCOUNE. ... ittt i ittt it e teeeeneanananans 33
Changing PassWord . ........iiii e 33
Forgot Password . ... .. e 34

B REPOMS. .ttt et e e 37
Site Asset Reports. .. ..o 37

Search Functions in Site AssetReports............. ... ... 38
Download Site Asset Report . ... 39
TlOg VIEW T . o e 40
Search Functionsin Tlog Viewer .......... ... i, 40
Download Site Asset Report . ... 41
Summary Report . ... o e 42
Summary ReportDetails. ........ .. .. 43

9 Password Management (Enterprise) ...............ccovunn... 45

Configuration SYNCING .. ... 45
Initial Onboarding . ... 45
ConfigurationUpdates ............. i 45

Password Management. . ... ...t 46
Manage Passwords . ......oo ittt e 46
Password Creation Errors. .......... ... . o i i 50

10 Loyalty (Enterprise) ......covvuiiiiiiiiieiiiiieiiiieneennnn. 53

Configuration SYNCING .. ... i 53
Initial Onboarding . ... 53
ConfigurationUpdates ... i 53

Loyalty Programs. . ... e 53
Create Program. ... ..o 54
Clone from Existing Program. ...t 57
Add Loyalty Cards ...ttt 58
Site Assignment . ... ... 59
Loyalty Merchant ID (MID) . ...ttt i 60
Review the Parameters. ... ... ... i 61
View Existing Loyalty Programs .. ...t 62

11 Mobile Payment (Enterprise) .........cccovviiiiiiiiiinnnn... 65

Configuration SYNCING . ... oo 65
InitialOnboarding . ... 65
ConfigurationUpdates ...t i 65

Mobile Payment Programs ...ttt 66
Create Program. ... ... 66
Edit an Existing Program. . . ... ... 69
Delete an Existing Program . ... 70

™
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. ii



Verifone C-Site Management User Guide

MID BUlk Upload . ..ot e e 71

12 Primary Payment (Enterprise) ...........ccoiiiiiinnnn... 73
Primary Payment Programs ......... ... i e 73
Create Program. ... ..ot 73
1071 o I o4 (ot = 79
CashbaCk & Fees ... e e e 80

13 Site Configuration. ...ttt 81
Configuration SYNCING . ...t 81
Initial Onboarding . ... 81
ConfigurationUpdates .......... ... 81
Site Search ... .. 82
Replicate Configuration . ......... .. e 83
Store Operations . ... 86
Method of Payment (MOP) ... 86
CUITENCIES. . ittt e e e e e et 90
FEES oot e o1
TaX Rates ..o e 92
CategOriES oottt 93
Departments ... ..o 94
PLUS . o e 96
BlUue Laws . ..o e e 99
AddingaBlueLaw. ...........oo i 99

ID ChECKS .ttt 101
SalES. o 103
Sales Configuration. ... ... ... . 103
Login/Logout Message ..ot 108

Menu Configuration . ........ ... i 109
TOUCh SCreeN. . ..o e e M
Panels Configuration. ......... ... .. i 111

fem Panels. . ... e 112
Vieworeditanitempanel ........... ... ... .. 13

Parked MenuPanels ...... ... ... i, 116

Fuel Panels . ... . i e e e 118
FuelDetails. ... e 119

Screens Configuration. ......... .. i 120
AddaNew Screen ..ot i 121

View or Editan ExistingScreen ............. ... . ... 123

Registers Configuration .......... ... 125
OPtIONS Lot e 125
Configurations ........ .. i 126

View or Edit an Existing Register . ........................... 127

T P ING . e e oot 130

-
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved.



Verifone C-Site Management User Guide

Payment Operations. ... 131
LOYaY ot e e e 132
Parameters ... .. . e 132

CardS. . i e 133
General Settings ... 134
MObIlE o 136
EditSiteDetails ... 136

Edit Program Details. . ... i 137

Copy Mobile Configuration............ ... ... . ... 139
Disable Mobile Payments for an Individual Site. . .................. 141

Mobile Payment Configuration Troubleshooting ................. 142
Primary Payment. . ... .. e 143
Card Price Tiers .. ooi i e e e 143
CashbaCk & Fees. ...t e 144
ACCESS CONtrOl . .ottt e 145
POS SECUNtY .ot 145
EMpPIOYEES. .o e 145
Security Controls . . ... 146
SalesFunctions ....... ... 147
FOrECOUM . . e e 148
DCR Configuration ... 148
Receipt Settings. ... 148
Receipt Header. ... o 149
Receipt Trailer. . ... e 150
Prompt Settings. ... 151

Other Settings. ... 153

DCR Settings. . o oottt 154

Key Configuration ......... ... i 156
Assigningan MOPtoaDCRKey............co i, 157
Assigning a Combinationtoa DCRKey.......................... 159
Assigning a FunctiontoaDCRKey ......... ..., 161
Assigning a NumerictoaDCRKey. ...t 164

DCR Settings = Position Settings ............... ... o i, 168

Select DCRPOSItION . ..ot i 169

FUEL. o e e 171
FUBI PHCES . ot e e e 171

Fuel Configuration. ....... ... i 172

Fuel Tax EXemptions .. ..o e 173

14 Viper Table Management........... ... .cciiiiiiiiiiienn... 175
15 Connect DevicetoCloud .............ciiiiiiiiiiiiinn... 177
ReqUIrEMENtS . .. o e 177
Pre-Release 54.02 - Connecting Device to Verifone C-Site Management.. 178
Troubleshooting . ... 182

.
Ve rlfone Proprietary + Confidential. © Verifone Inc. All rights reserved.



Verifone C-Site Management User Guide

HOSt ROULES. . .o e et 183

DNS Settings. ..o oo 183

Release 54.02+ - Connecting Device to Verifone C-Site Management .... 184
Troubleshooting. ...t 185

16 One-TimePassword. .........coiiiiiiiiiiii it iieineennnn. 187
REQUIrEMENtS . .. o 187
Configuring OTPEMalls. ... i 187
Usingthe OTPto Email Feature......... .. ... . o i, 190

AN A Y o] o Y= Vo |7 G 191
Verifone Commander Release 53.41 . ... ... ... i 191
Verifone Commander Release 54.00and 54.01......................... 193
VN ONE . . o 196

.
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. Vv



INTRODUCTION

Verifone C-Site Management is a web application that enables Petroleum Merchants and Major Oil
administrators to maintain a centralized point for site data, monitor sites remotely, and provides a
convenient platform for synchronous oversight and configuration.

Verifone C-Site Management does not require a technician to visit each location to make changes and
updates. Updates can be done selectively or all at once from the web application.

This guide covers the following topics:

Hierarchy: Setting up and managing hierarchy, the arrangement of groups and sites to reflect the
business structure (e.g. National > Regional > Western > Pacific).

Sites: Setting up and managing sites (individual business locations) within the hierarchy.

User Administration: Creating and managing users with various roles and permissions (e.g. access to
administrative or reporting features within the C-Site Management application)

Dashboard: An overview of the application's dashboard, from which the features can be accessed, view
configuration steps (and their completion status), and find information on additional help and support.

My Account: Information for users on viewing their account information. Editing user information is not
available currently.

Reports: Reporting allows near-real-time data for Transaction Logs (T-Logs), Site Assets, and Summary
details to be readily viewed.

Configuration: Remotely manage and synchronize site configurations for Password Management,
Primary Payment, Mobile Payment, Loyalty Configuration, Viper Card Tables, and various site price book
configurations.

Connect Device to Cloud: This feature allows the connection to the Verifone Commander to the
Verifone C-Site Management cloud application.

One-Time Password: This feature allows the One-Time Password (OTP) to be sent from the Verifone
Commander to an email address to access the OTP-dependent features of the Verifone Commander.

.
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System Requirements

If the Verifone Commander is not onboarded to the Verifone C-Site Management
within a certain amount of time, it will not be able to perform merchandise and fuel

transactions.
E]@ WARNING See the Appendix | section for specific details.

In release 55.01, the requirement to onboard onto C-Site Management still exists,
but merchandise and fuel functionality will not be disabled.

Software Requirements
* Verifone Software Release: Support begins in 53.35+

* Web Browser: Microsoft Edge, Chrome, Firefox, or Safari accessed through a computer.

Software Release Specific Implementation

Release Features Supported

53.35 Tlog Viewer, Site Assets, OTP

53.41 Mobile Payment Configuration, Viper Table Set Management

54.00 Loyalty Configuration

54.01 POS Configuration, Commander Configuration Acknowledgment

54.02 POS Security, Fuel Tax Exemptions, Enhanced C-Site Onboarding Support, Major oil accounts can

use loyalty configuration from C-Site Management

55.00 PLUs, Sales Configuration, Login/Logout Message, Fuel Pricing - Pending, Fuel Configuration - In
Effect

55.01 Dealer Location ID Presented in Site Asset Report

55.02 Caloric Values, DCR Configuration, Primary Payment Configuration

56.00 Menu Configuration (Read Only), and Touch Screen Configuration

56.01 Tipping, Verifone Commander Password Management, Replicate Configuration

.
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Version Support Notification

C-Site Management has been enhanced to display when the connected site's software release version
does not support specific forms. Messaging will appear that states ‘This Version (xxx.xx.xx) does not
support configuring the form, please upgrade your Commander.

Software upgrades can be requested through Verifone's Remote Software Delivery (VRSD) process. See
the VRSD Implementation Guide for more details.

Store Operations fa
This Version (054.02.00) does not support configuring the form, please upgrade your commander

MOP

Currencies
Fees

Tax Rates
Categories

Hardware Requirements
* Verifone Commander with supported POS
» Computer (Desktop or Laptop) with the most recent security updates
* Managed Network Service Provider (MNSP) Implemented

e Broadband Internet Connection

Account Sign Up

1. To create an account for Verifone C-Site Management, navigate to the following URL and select 'Sign
Up for Free'.
https://petromop.verifone.cloud/home

Verifone' C-Site Management

Smart monitaring and reporting
for your petroleum business

Sign Up for Fres

ot el

®
® -
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2. Complete and submit the form presented.

Sign Up for Verifone C-Site Management

Barly access, Por exdsting customers cnly. Mo credit card required
Full Bamg

Company Mare

meany Mama

Corporuta Emal

T e T T Dy TR TR T

Diary Tirrss Prazog Musmibar

Seate

[E]ﬁ NOTE If the administrator has more than one store, only one account is needed.
All sites should be onboarded to one account.

-
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. 4



%

Verifone C-Site Management Use Guide

Terms and Conditions

When logging into Verifone C-Site Management, a prompt appears to accept the terms and conditions. To
log into the application, accept the terms and conditions to proceed.

To view the Terms and Conditions, select the blue text in the prompt.

Welcome to your Verifone Central accountl

Before you get started please read and acospt Verifone Central's

erms and Conditions
Logout Accept Termns & Conditions

At anytime, the Terms and Conditions can be reviewed by clicking on the profile icon in the upper right-hand
corner of the screen and selecting “Terms” from the menu.

My Account

OTP Setfings

Terms

Support

Logout

.
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Website URL

To access Verifone C-Site Management, navigate to the following URL using a web browser:

https://us.live.verifone.cloud/

- i
.‘! arifone English

Sign in to Verifone Central

Emnail

Password

protecied by reCAPTCHA ™
Frivacy - Tems

Eorot nasowond?

-
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HIERARCHY

This section provides an overview of how to edit and manipulate hierarchies on the Merchant
Administration page. A hierarchy structure allows the building or mapping of the business structure within
Verifone C-Site Management. Hierarchies should be configured before adding sites to Verifone C-Site

Management. This allows more effective use of the Bulk Site Upload feature.

View Hierarchy

1. Log into the Verifone C-Site Management application.

2. Click on Administration > Site Management > Hierarchy.

3. Use the Search bar to search for the name or use the collapsible menu below the search bar.

Hierarchy

Edit Hierarchy

o
o
1]
—
o
—
=)

by Mame in Hierarchy

Expand All Collapse All

> Topline (83) @¢—

-
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Edit Hierarchy

[jﬁ NOTE If a new Merchant Administrator has not set up any hierarchy for the account, the display

page will show the company name with any sub-entries all in one group.

1. Hierarchies can be edited by selected the Edit Hierarchy button in the top right corner of the Hierarchy
window.

HierarChy - Edit Hierarchy

Search by Name in Hierarchy

Expand All Collapse All

2. The following icons will appear next to the hierarchy names. Not all icons will appear next to each name
based on the available functions for that row.

~ H'G!EITC"":.'
Hierarchy
Search by Mame in Hierarchy

Expand All Collapse All

w Topline (83)

» California (12) = - ale o

B8i

-
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Icon Description

Edits an existing groups name.

4
Adds a sub-group to an existing group.
_|._
Reorders icons by selecting the group to move from the list, and then dragging and dropping the
$ group.
Adds a new group to the highlighted row. The new group name prompt will appear below this line
when selecting this icon.
Ay
wo Toplng
[T
Deletes a group
(i

.
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Search

Key in the name of the group in the search field to narrow down the hierarchy to the entered characters.

Hierarchy Edit Hierarchy

=t | <

Expand All Colapas Al

™
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SITES

Sites (stores) are the individual C-store/gas station at which the Verifone Commander resides. The Verifone
Commander at each location must be setup to communicate to the Verifone C-Site Management system in
addition to being onboarded through Verifone C-Site Management. Those details are discussed in the
Connect Device to Cloud section. This section will discuss how to add or onboard sites to the

Verifone C-Site Management system individually or in bulk.

Required Site Information

The following information must be obtained from the sites you wish to onboard to Verifone C-Site
management:

* Verifone Service ID as shown in the site’s contract.
 Sijte’s Name
¢ Site’s Address

¢ Sijte’s Phone number

View Hierarchy
1. Log in to the Verifone C-Site Management application.
2. Click on Administration > Site Management > Hierarchy.

3. Use the Search bar to search for the name or use the collapsible menu below the search bar.

[jﬁ NOTE Make sure the hierarchies used for the site are configured prior to adding the location to the
dashboard.

™
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Bulk Site Creation

Bulk site creation is used to onboard up to 2,000 sites to Verifone’s C-Site Management rather than one site
at a time. This feature utilizes an Excel Spreadsheet where site information such as service ID, address, and
hierarchy assignment are entered in a spreadsheet and then uploaded to the cloud. The data entered is
checked for validity after it is uploaded to the cloud and a Bulk Upload Report is generated to provide
information on whether the site creation was successful.

Downloading the Template

1. Navigate to Administration > Site Management > Sites.

2. Select Create Site in the top right corner of the menu.

Sites —

Site Mame  w Search Criteria Q, Search

Hierarchy Add filter +

Site Name ServiceID¥  Status ¥ Status Received At Hierarchy Site ID %

3. Select Create in Bulk.

Create Site

Bulk Creation .
Manual Creation
Upload a XLSX file and add

o ) Add sites manually using a simple
hundreds of sites in a few clicks.

. ) . farm. This is an ideal way for
Sites will be automatically

i i adding one or several sites.
assigned to your hierarchy.

Create Manually

Create in Bulk | <

@
® ™
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4. Click on Downloading Excel Template File.

Create Site
(o]

Template Download Sites Upload Done

Template Download

Start by Downloading Excel Template file. <—
Open it and fill in information about your sites
ar Continue if you are already downloaded

Petro Cloud Template & [0 & Sevedus Dive
File Edi View Insert Format Dota Tools Addons: Help  Lasiedil was seconds o0

oo B P 9% - § % 0 00 13- Defmmiei - W - B T & A
L M -—

12345 00838 Exampla Sie  SF Ragea 22 Examphs Streel. San Frandias
12389 10T Tes Sae LA Reglon 04 Torst Bibed, Vierdura

may need to Enable Editing depending upon your Microsoft Excel version.

Excel Pebo Clowd_Temgdlate - View-only ~ L} Sparch (ARt « )
File Haiew Ingaget D FPage Langcat Formulis Data Rt Wi Halp L Cemments
v w ] Ty D | e
O Y A
i -
A I I |
Site 1D Sub prowp 1 Subgroup? | Sub 3 Adkdiry *

-
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6. Enter in the site information, one site per row. All fields that have an asterisk (*) are required. After all
the entries are completed, save the changes made to the spreadsheet.

Field Description

Service ID* The Verifone Service ID shown in the site’s contract with Verifone.

Site ID Any ID number used by the organization operating the site.

Site Name* The name of the site. This is useful when searching for sites. You must enter a site name and it must

be unique to the site.

Sub Groups® Assign a site to a location in the hierarchy using the Sub Groups. The hierarchy subgroups must
exist before the bulk upload, or the site will be added to the root company.

Street Address*® The physical address of the site.

City* The municipality in which the site is located (or equivalent).

Zip Code™ The ZIP code for the site.

State* Choose a state from the drop-down list.

Custom Attributes You can create your own attributes for sorting and filtering sites. See below for more information.

WARNING A valid Verifone Service ID MUST be entered. If the entry is incorrect the site will not
E]ﬁ be onboarded.

7. Return to the Template Download page on Verifone C-Site Management and select Continue at the
bottom of the page.

-
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8. Drag and drop the Petro Cloud Template Spread sheet in the dotted area or Browse files and locate the

file to upload.

Create Site

your sites. Save the file and uplosd it beiow.

Tempdabs Dowrikoad Sives Lpoad
Sites Upload
Opean the ernplane which you have downloaded and fill it with information abous

=]
¢

Dvag and drop XLEX file here

Brovwse fies

_>

9. After the file is ready to transfer, the ‘Drag and drop XLS file here’ will update to the name of the file

selected. Click Continue to upload the file.

10. The Done screen will appear. A transaction ID for the upload will be generated for your reference. From
here, you can select reports page on the screen to view the Bulk Upload Report, or you can navigate to

View Sites.

Create Site

Done

Upload has been procesked sucoessiuly, Save trenasction id : 1000075 for
redaringd, Youn can chbok the S1BIUS in repits page

™~

verifone

Proprietary + Confidential. © Verifone Inc. All rights reserved.
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Bulk Upload Report

After a bulk site upload is completed, a Bulk Upload report is generated to provide details on which sites
were successfully added to Verifone C-Site Management.

The report can be accessed by selecting the ‘reports page’ text in blue (shown above) or by navigating to

Verifone C-Site Management User Guide

Administration > Site Management > Bulk Upload Report. Each Bulk Upload performed has a Transaction
ID generated, allowing you to review the specific Transaction ID in the reports list.

A status is generated to let you know if there was an Error in the upload, or if the upload completed

successfully. Since multiple sites can be uploaded at the same time, an Error response will appear even if

there is only one site that had an issue. If all sites upload without any errors, the Status will show a green

Success.

Bulk Upload Report Errors

The following errors may occur during upload. Utilize the table below to resolve any errors that occurred
during the upload. Be sure to select the Transaction ID associated with the upload.

Error

Mandatory Fields
Required

Invalid Service ID
Range

Service ID Not Found

Site Created
Successfully

Invalid Attribute. Site
Created Successfully

Invalid Subgroup
Combination Found.
Invalid Attribute. Site
Created Successfully

o' verifone

Description

If any mandatory fields are missing (Service ID,
Site Name, Address Line 1, Country, State, City,
or Zip code).

If the Service ID Length is less than 7-Digits.

Service ID Not found in CRM Database.

Site Created Successfully.

Site created successfully and an invalid
attribute was found.

Site created successfully but has an invalid
subgroup name and attribute combination.

Resolution

Confirm that the information is present in the
mandatory fields and upload the site again.

Confirm the Service ID entered is 7-Digits.

Confirm the Service ID is a valid Service ID.

Upload completed without any errors.

The site was added to the Sites list, but an
attribute was invalid. Make corrections to the
site on the Administration > Sites page.

An invalid attribute and subgroups (hierarchy
assignment) were found in the uploaded
document. Make corrections to the site on the
Administration > Sites page.

Proprietary + Confidential. © Verifone Inc. All rights reserved.
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Error

Invalid subgroup
combination found.
Site Created
Successfully

Site Name Already
Exists

Duplicate Service ID
and Site Name

Duplicate Service ID

Duplicate Site Name

Site: Entity Service
Error

Address: Entity
Service Error

Mandatory Fields
Required

Invalid Service ID
Range

o' verifone

Description

Site created successfully but subgroup
combination is incorrect.

The site name already exist in sites table.

A duplicate Service ID and Site Name
combination found in the upload document.

A duplicate Service ID was found in the upload
document.

A duplicate site name combination was found
in the upload document.

Site entity service failure.

Address entity service failure.

If any mandatory fields are missing (Service ID,
Site Name, Address Line 1, Country, State, City,
or ZIP code).

If the Service ID Length is less than 7-Digits.

Verifone C-Site Management User Guide

Resolution

The subgroups (hierarchy assignment) was
invalid in the uploaded document. Make
corrections to the site on the Administration >
Sites page.

Either change the existing site record’s name or
change the site name in the upload document.
The site will need to be added again after
changes are made.

Remove the duplicate records and upload the
site again.

Remove the duplicate service ID and upload
the site again.

Remove the duplicate site name and upload

the site again.

Attempt the upload again.

Attempt the upload again.

Confirm that the information is present in the
mandatory fields and upload the site again.

Confirm the Service ID entered is 7-Digits.

Proprietary + Confidential. © Verifone Inc. All rights reserved. 17
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Manual Site Creation

Manual creation is intended to be used to add one site at a time. To add multiple sites, use Bulk Site

Creation. Manual creation utilizes a web form to fill in the required site details to onboard the site to Verifone

C-Site Management System.
1. Navigate to Administration > Site Management > Sites.

2. Select Create Site in the top right corner of the menu.

3. Select Create Manually under the Manual Creation section.

Create Site

Bulk Creation )
Manual Creation
Upload a ¥LSX file and add hundreds of sites

Add sites manually using a simple form. This is
in a few clicks. Sites will be automatically

an ideal way for adding one or several sites.
assigned to your hierarchy.

Create Manually |-f——

Create in Bulk

-
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4. Complete the Site Details form. Service ID, Site Name, Address Line 1, Country, State, City, and ZIP Code

are required (*) fields.

Create Site

Site Details

Service ID*

Site 1D

Site Name *

+ Add custom attributes

Country

United States of Ameics L

+ Add address

Hierarchy

Asslon & st 1o hisrarcin: ues the aooanding et basiom
Assign & site to hisrarchy, use the sxpanding st below

o desined hisrarchy level and click ‘Re-assign 1o this

The site is assigned to Topline

navigate
group

Field

Service ID*

Site ID

Site Name*

Custom
Attributes

Street
Address®

City*

Zip Code*

State*

Hierarchy*

Definition

The Verifone Service ID shown in the
site’s contract with Verifone.

Any ID number used by the
organization operating the site.

The name of the site. This is useful
when searching for sites. You must
enter a site name.

You can create your own attributes
for sorting and filtering sites. See
below for more information.

The physical address of the site.

The municipality in which the site is
located (or equivalent).

The ZIP code for the site.

Choose a state from the drop-down
list.

Assign a site to a location in the
hierarchy using this feature, by
navigating to the correct location in
the hierarchy, clicking on it, and then
clicking “Re-assign site.”

5. After filling in the fields is completed, click Create Site to add the new site or Discard to return to the

Sites window.

verifone
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Custom attributes allow users to search for sites based on specific criteria relevant to those sites, such as
brand of fuel sold, software version on the site controller, type of installation, etc. Up to five attributes can

be added per site.

1. Select the + Add custom attributes within the create site form under the Manual Site Creation form.

2. Enter the name for the attribute in the field that appears.

3. Enter a value in the field provided.

Site Marme *

Custom site name

You can search sites by this name.
Attribute 1

Marne Value m
Custom attributes allow you to filter sites list using attribute. e.g. by fuel brand,

4. To delete an attribute, select the Trash can icon.

5. When selecting Create Site, the custom attributes will be added along with the rest of the site data.

verifone
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Editing Existing Sites

1. To edit a site, select the site from the site list.

2. Inthe top right corner of the screen, select Edit Site.

Verifone C-Site Management User Guide

3. Changes can be saved (Save Changes) or Discarded (Discard). The site can also be deleted by selecting

Delete Site on the bottom left corner.

1.8.0 - Demo

Site Details

Service 1D

Cdutry

Hisrarchy

The ste i assigred o Peschines

Assign & sie b0 hisranchy, use the ewpanding kst beiow, nerigabe to desined

[jﬁ NOTE To re-assign a site's hierarchy, select the 'Re-Assign Site' button on the Site Details page

(before selecting the Edit Site button).

-
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ROLES

The Roles feature is used to assign different permissions and features to a single or multiple users. It can
restrict users or groups of users from accessing various features.

To navigate to Roles, select Administration > User Management > Roles.

Roles

Role Name w

Created Date ~w

Search Criteria

Add filter +

)5

MName % Status % Created By % Created Date %

No Access m ndigo Violet 9/4/2023 >

Write Access ndigo Vialst 942023 3

Read Only Active Indigo Violst WA/2023 >
NOTE

verifone

Verifone will configure default role permissions for the application. Administrator users will
need to create roles using the permissions, and then assign them to users.

Proprietary + Confidential. © Verifone Inc. All rights reserved.
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Adding User Roles

1. To add user roles, navigate to Administration > User Management > Roles and select Add Role at the
top of the page.

Roles

Created Date

Name ¥

Mo Acress

Role Name  w Search Criteria

Add filter +

Created By ¥ Created Date ¥

2. Complete the form by entering at least a role name and selecting appropriate permissions. Use the table
below for more details.

Field

Role Name

Role Description
Status

Copy Permission from
role

Administration

Configuration

verifone

Description

A name to easily identify the role that is unique and accurately describes the permissions assigned to
the user. Ex. Store Manager, Pricebook Manager, Accounting

An optional field where you can describe the roles’ purpose and function.
Allows the role to be enabled to deactivated.

Clones all permissions from one user role to another. Useful if you want to then add or remove a single
item.

Site Management: Allows the user to access the Sites features under the Administration menu. (For
more information, see the Site Management section.)

Roles Management: Allows the user to access the User Roles functions.

User Management: Allows the user to access the Users functions under the Administration menu.
(For more information, see the User Management section.)

Store Operations: Allows the user to access site specific configurations related to store operations
such as MOP, Tax rates, Departments, Access Control, Fuel Prices, Fuel Configuration, etc.

Payment Operations Configuration: Allows the user to edit and/or access Primary Payment, Mobile
Payment & Loyalty Programs and site-specific configurations (For more information see the Primary
Payment, Mobile Payment, and Loyalty sections.)

24
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Reports Site Assets: Allows the user to run Site Asset reports.
TLog: Allows the user to run Transaction Log reports.

Summary Report: Allows the user to run Summary Reports.

-
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CREATE USERS

NOTE
[j@ Before creating users, Hierarchies, Sites, and User Roles must already be configured.

1. To create new users, navigate to Administration > User Management > Users.

2. Click Add User in the top right corner of the screen.

3. Complete the required fields using the table below for reference.

Field

Name

Email

Status

Role

Site Assignments

Deleting a User

Description
Enter in the name of the user. It is recommended to use the First and Last name in the name field.

Enter in the email address for the user. It is recommended to use company email addresses when
possible. The email address is used for logging into the Verifone C-Site application.

Users can be set to active or deactivated if they no longer need access to the Verifone C-Site
Application.

Assign the role from the list that best fits the users job functions. Refer to the Roles section for more
detail on roles and role permissions.

Users can be assigned to specific hierarchies, meaning they can be permitted access to only a subset
of sites. If the user requires access to all sites, then select the first option under site assignments
which will select all locations.

1. To delete users, navigate to Administration > User Management > Users.

2. Select the user from the list.

3. Select Delete User on the bottom left corner of the User Detail screen. To utilize the same email
address, the Verifone Helpdesk must be contacted to fully remove the users email address.

-
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Creating an Additional Administrator Account

Only one site administrator exists when the account is created initially. If you need to create additional users
with the same access level then the user’s role will need to be modified.

1. Login with the current Petro Site Administrator account.

Navigate to the newly created or existing user and select them from the user list under
Administration > User Management > Users.

After the user is selected, click Edit User from the top right corner.

Update the user’s role to

Petro Site Admin from the Role drop down.

N o o s AN

Click Save Changes.

Edit User Discard

User Details

Mame

Ermail

Status

m Deactivated

Rle

Petro Site Adrmin v | < —

™
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DASHBOARD

This section discusses the Verifone C-Site Management application Dashboard. The dashboard provides
information on active sites, offline sites, latest sites added, pending authorization sites, and devices.

The Dashboard is located under C-Site Management > Overview > Dashboard.

NOTE Not all users will have access to all these features. Feature access will depend on a user’s
permissions. See the User Role and Users sections for more information.

Dashboard
Get an overview of all devices connected o Commander on your Sites.
Use search and filter to find exactly what you need and export results in CSV.
7 Active Sites 30 Offline Sites Devices
View atinve sites View offline sites
RSpenser 13
Reqister 35
; . : x Commander 13
Latest Sites Pending Authorization
View latest sites View pending sites other 32
Store & 10 Store # 15 Pinpad 21
Store # 11 Store # 16 DR 16
Store # 12 torc # 17 Carwash 14
Store i 13 Store # 138 Tank Gauge !
[Store # 14 Store #19

-
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Dashboard on Initial Login
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Here is a sample dashboard layout with some steps already completed. You should work through each
step-in sequence to properly configure the application. See the Hierarchy, Sites, Roles, and Users sections
of the documentation for information on configuring each of these areas.

1. Hierarchy: Add and view hierarchies, which are lists of groups of sites as your business organizes them,

e.g., National > Regional > State, etc.

2. Sites: Create and manipulate lists of sites that sit in various levels of the hierarchy.

3. Roles: Create user roles so you can assign permissions (configured by Verifone) to individual users or

groups of users at one time.

4. Users: Create and manage user profiles for users who need to log in to perform various functions in the

Cloud application.

You are only a few steps away to complete the setup

1. Hierarchy 2. Sites

Create a hierarchy view of Create a list of sites and
Your petraleum business arrange them into the
ta assign indiadual sites, hierare hy.

Welcome to Verifone® C-Site Management!

Below are few things to configure before you can see real time data and reports.

3. Roles

Create roles to grant and
restrict accessto all

fearures for your Users.

Create Roles

4, Users
Create user profiles so

that your sub-users could
start using the application

Create Users

(@ We are here to help

Feel free 1o contact us if you are CHPETIENCING My IB5UCS SCITING Up your acCount.
Call 1-800-VERIFONE. We are available Monday to Friday, Qam to 6pm EST time

-
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After you have completed all the setup steps, and have active Sites, the Dashboard will look like this:

Verifone C-Site Management User Guide

Dashboard

7 Active Sites

View allive Sites

Latest Sites

View latest sites
Store # 10
Store # 11
Store # 12
Store # 13

|Store # 14

Get an overview of all devices connected to Commander on your Sites.
Use search and filter to find exactly what you need and export results in CSV.

30 Offline Sites

View offline sites

Pending Authorization
Yiew pending sites

Store # 15
Store # 16
Store # 17
Store § 18

Store # 19

Devices
Dispenser
Redqister
Commander
other

Pinpad

113

35

33

a2

21

%

verifone
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7 My ACCOUNT

The My Account section allows you to view and edit details regarding to your specific user account
including your name, language, and password.

To view your account information, click on the profile icon in the top right corner of the Verifone C-Site
Management web page after logging in. Select My Account from the drop down.

The first page will display the account’s General Information. To make any changes select the Edit User
button in the lower right corner.

Field

First name, Middle
name, Last name

Organization

Organization ID

Email

Roles

Status

Description

Shows the users First, Middle (Optional), and Last (Optional) Name.

Note: For some users the First Name may display the users email address or their first and last name.
This can be updated in Edit User.

Shows the organizations (company) name to which the user belongs.

Shows the Organization ID assigned to the company. This is a unique ID that is specific to the
organization.

Shows the user’s email address.

Shows all user roles assigned to the user. Role assignments cannot be changed in My Account. They
are changed under Administration > Users.

Shows if the account is enabled or disabled.

Changing Password

1. To change your password, login with your current username and password.

2. Select the profile icon in the top right corner of the Verifone C-Site Management website and choose
My Account.

3. Select the Edit user button under the General Information section.

4. Towards the bottom of the page select the Change password button.

-
Ve rlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. 33



Verifone C-Site Management User Guide

Password

Change password <—

Discard changes

5. Enter in the current password in the first field. Type in the new password in the new password and
Confirm new Password fields. Select Update to apply the new password.

» Passwords must be at least eight characters long and contain at least 1 number, at least one capital
letter, at least one lowercase letter, and at least 1 symbol.

* Passwords must be different from the users last 10 passwords.

Forgot Password

In the event a user has forgotten their password, there is a Forgot Password option at the login screen of

Verifone C-Site Management.

1. To reset your password, enter your email and select the submit button. After the email has been sent,
the user can no longer log in with their previous password. The user must reset their password following
the email instructions.

®
® -
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Sign in to Verifone Central

Email

Password

protected by reCAPTCHA [ "]
Privacy - Terma

Forgot password?

Forgot password

You will shortly receive an email with further
instructions.

Email

protected by reCAPTCHA

Privacy - Terms

&=

2. After the password has been reset, the user must log in with the new password.

-
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REPORTS

There are three different reporting options currently available within Verifone C-Site Management: Site
Assets, Tlog Viewer, & Summary Report. Reports are located under Commerce > Petro Reports.

L
'-: Uel'lfone Commerce Administratig C-Site Management
Cgmmerce Petro Reports
Manage business transactions seamlessly with a Commerce Site Assets
platform. Get detailed insights into payment reports and
streamline financial processes. Keep track of Petro reports Tlog Viewer
effortlessly and make informed decisions to drive business
forward. Summary Report

Site Asset Reports

The site asset report provides an overview of all devices connected to the Commander at the onboarded
locations. To locate the Site Asset Report, select Commerce > Site Assets.

Site Assets FE—

Gt an cverview of all devices connecied [0 Commancie: on your siles
Uise search and fiter to Find exactly what you rssd and euport resuls in CS5V.

— ' =

Dewices Msdel Software Hisrarchy 4+ Acid fiter

Servce 10§ Site ID@ Liocation 10 @ HHte Name § Device § Wendor § Wacdal § Hute Verson § SGaottware §

X

-
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Search Functions in Site Asset Reports

To search by Service ID, enter
: the Service ID in the search field
Slte F’iESE—'tS and click Search.

Get an overvew of al devices connected to Commandsr on your sites TO searCh by Site ID or

Ubses senrch and fifter 1o find suactly whsal you s and soport resuts miGSY Location ID, CIiCk the Service ID
drop down and change the
selection. Location ID
information is only available in
Softwnrg v Higrarchy + Ackd fitter release versions 55.01+.

To search by name within the
Seroce ID§ Site D@ Location |0 § Site Wame § Device § Hierarchy, click the Hierarchy
button and enter the name for
which you wish to search, and
click Apply.

To filter results by item in the hierarchy, click the Hierarchy button and
—_— use the checkboxes to select items (i.e., Florida and California in the
ierarchy + Add filte . X
screenshot below). When you have configured your search, click Apply.

The search results will appear on the Site Assets Report page.

NOTE The items that appear beside the check boxes under the filter criteria buttons (e.g.,
[jﬁ Commander, Register, Car Wash in the screenshot above) depend on the equipment that is
present at the site(s) you are including in the report.

-
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Reports can be filtered using the following criteria:

Field Description

Devices Shows the device type such as Dispenser, Register, Commander, PIN Pad, Other, DCR, etc.

Vendor Shows the Vendor of the product when applicable. For example, dispensers will show the dispenser
brand name when that information is available. Click + Add filter to see this option.

Model Select from the model information available (e.g., Commander > Ruby Ci)

Software Searches from the specific software for the device. For Commander software, this area shows the

Release version of the software. For PIN pads it will display the entire software name and version.

Suite Version Displays the specific Commander application version and green box version when applicable. Click +
Add filter to see this option.

Hierarchy Allows for the search information to narrow down locations based on their hierarchy organization.
Multiple or individual sites can be selected using this option.

Download Site Asset Report

The information shown can be downloaded in a .csv file format and saved to the local computer. If the
information is filtered/searched, then the report download will populate with the displayed information.

Selecting Download Report on the Site Assets main page will prompt for the report to be downloaded.

Site Assets _> Downboad Report
Get an overview of all devices connected to Commander on your sites
Use search and filter to find exactly what you nesed and sxport results in G5
I:I:. o : N .
Devices Model Software Higrarchy =+ Add filter
® : 1 N
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The Tlog viewer feature allows for financial transaction logs or transaction journal entries to be viewed from

Verifone C-Site Management. Only the last 7-days of Tlogs are available for review.

To locate the Site Asset Report, select Commerce > Tlog Viewer.

NOTE
[jﬁ This feature is only available to Merchants and Retailers.

Search Functions in Tlog Viewer

The Tlog viewer search requires a service ID or a site (one) selected from the Hierarchy drop down to

perform a search.

Tlog Viewer

Saervice |D

Hierarchy

Fizase salact a Service ID to view the Tiog

Field

Service ID

Date: Predefined

Date: Custom

Type

Hierarchy

Add Filter: Trans Types Use the check boxes to select from the transaction types configured on the system.

Description

enter the site’s service ID.

Choose from Today, Yesterday, or up to the last 7 Days.

Select a date using the calendar controls. You can only select the last 7 days.

(Default) Select Service ID from the drop-down menu to the left of the search criteria text box and

Use the check boxes to select Financial and/or Journal entries. Financial is selected by default but can
be changed by selecting the Type drop down.

verifone
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40



Verifone C-Site Management User Guide

Add Filter: Journal Use the check boxes to select from the journal entry types configured on the system.
Types
Results per Page Select how many entries you wish to view at a time (Default is 10).

[jﬁ NOTE Click on the record to view the transaction details. Details will vary based on the
transaction type selected. Transaction logs will never display full card numbers.

Download Site Asset Report

The information shown can be downloaded in a .csv file format and saved to the local computer. If the
information is filtered/searched, then the report download will populate with the displayed information.

Selecting Download Report on the Tlog Viewer page will prompt for the report to be downloaded.

Tlog Viewer —_—

Higrarchy

Flease select a Service ID 1o view the Tiog

-
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Summary Report

The Summary Report provides data about merchandise sales by category and fuel sales. To access the
summary report in Verifone C-Site Management go to Commerce > Summary Report.

NOTE
[j@ This feature is only available to Retail administrators and their users.

Summary Report

Service IDx

-~ ™
Date ~w | Hierarchy (+1) ~ | Clear filters

. 0 e,

Please select the Date to get the report

To view the summary report, a date and location must be selected. Location can be located by using the
Service ID or the Hierarchy selection. Select the date and sequence number result to view the summary
report details.

NOTE Only one date can be selected at a time. Reports are archived within Verifone C-Site
[j@ Management and accessible for only one week. The week is based on a calendar week
and not the site's day close.

-
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Summary Report Details

Field

Site Information

Period Open/Close

Merchandise Sales

Category
Description
Sales

Void Amount
Void Count
Overall Total
Fuel Sales
Fuel Cnt

Fuel Amt
Fuel Gallons
Void Fuel Cnt
Void Fuel Amt
Drive Off Cnt

Drive Off Amt

Description

Shown in the top row. From here, you can click See Site Info to view the site’s information, but this
will exit the report and you will have to generate it again.

Shows the date selected for the report.

Shows the Category number for the transactions.

Shows the category description for the transactions. This is configured in the POS system itself.
Shows the sale amount for each transaction.

Shows the dollar amount on sales cancelled by the cashier.

Shows the number of cancelled sales.

This row shows the totals for each column for every transaction in the period.

Shows the total number of fuel sales transactions.

Shows the dollar amount of fuel sales.

Shows the number of gallons of fuel sold per transaction.

Shows the total number of fuel sales cancelled by the cashier.
Shows the dollar amount of cancelled fuel sales.

Shows the number of fuel sale transactions that were not paid for.

Shows the total dollar amount from unpaid-for fuel sale transactions.

-
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PASSWORD MANAGEMENT (ENTERPRISE)

NOTE
[j@ Password Management requires Verifone Commander 56.01 release version.

Enterprise Password Management in Verifone C-Site Management allows for password settings to be
configured and managed in the cloud, and then transmitted to a single or multiple Verifone Commanders.
Support for password remote management within the Verifone C-Site Management application requires
software Release 56.01 or higher.

Configuration Syncing

Initial Onboarding

When the Verifone Commander is initially onboarded into the cloud, if it is on Release 56.01 or higher, it will
transmit its current password management to the Verifone C-Site Management application.

The current password management is only transmitted to the Verifone C-Site Management application
during the initial onboarding.

Configuration Updates

After the initial upload of the current configuration, any updates made in Verifone C-Site
Management can be accessed and transferred to the site by either the major oil provider and/or the
merchant administrator (if applicable.)

After the site is onboarded to the cloud, User Administration will still be available within Verifone
Configuration Client.

If there are local changes within Verifone Configuration Client made to the User Administration at the
site, these changes will NOT be transmitted to Verifone C-Site Management.

If updates are sent to the site from Verifone C-Site Management, the last update sent will override
previously transmitted or locally stored data.

-
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Password Management

Managing passwords in Verifone C-Site Management involves securely storing and accessing passwords
from single or multiple Verifone Commanders. This is done using Password Management.
Manage Passwords

1. To manage passwords, navigate to C-Site Management > Configuration > Site Management and
select the Sites drop-down menu and switch the view to Enterprise.

Enterprise - @ Viewing: Loyalty = Create New
Provider Bl San T m

2. After navigating to the Enterprise view, select Filter in the middle of the screen.

X

-
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Filter Configuration x

Configuration Category:

.:f..C ommander User Management B 1‘_
Configuration Type:

I:f..F'as sword Management v“‘_

Select Commander User Management from the Configuration Category drop-down menu.

4. Select Password Management from the Configuration Type drop-down menu.

Click Filter to view Password Management.

Enterprise « @ Viewing: Password Management — R

Created Date Commander Lisar Name i Of Sites

2025-03-21 124305 managess 1 >

6. Click Manage Password to select and edit a password at one or more Verifone Commanders.

X

-
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Manage Password *

Commander User Name Password Guidelines

\erifone

Mew Password

EEEEEEEEE s :5'.'. vords must match
* You cannot reuse your last four passwords.

Confirm Password

BEsEREEEE

Select Site(s) * Feature is available from 56.01 onwards

» VH Petro Enginesring

[ ]
o
0
fo
o

10.

1.

verifone

Key in the Commander User Name for the selected site(s).
Key in the new password using the Password Guidelines on the right side of the form.
Key in the new password again to confirm.

Search or select the sites for the new password.

Click on Validate to make sure Commander User Name is correct and the new password meets the

criteria OR click Discard to remove changes.

Proprietary + Confidential. © Verifone Inc. All rights reserved.
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Manage Password .
Gite Name Status Sarvice 1D Bite Stabus Daescrigithon
Apnl Reloase | SUCCESS BOZO0TE | ACTIVE |
1ol Pagaial1

13. After the new password is applied, Download Report if needed. The sites can be filtered on the Manager
Report Details by clicking on the column headers.

-
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If the new password does not meet the guidelines and the Verifone Commander rejects it, an error will

display.

Manage Password

Tsites: |

St Mt St
A Rieace
1miail

Sarvize ID St Gralud

sas007s aeTvE

Re-upe of recent password not_

Re-use of recent password not alicwed

Pageief1

verifone
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If the username does not match the configuration in Verifone Commander, an error will display.

Manage Password

1 sdtes : Password was not acceptad. Flease refer 8o the information beiow. The

Gite Mame Sarvice ID Site Status Seabui Dascription

Apri Releass Ea300ME - User configumtion not found.
Usar configuratisn mot
fund

11z 10f 1 Page1aof1

-
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1 O LOYALTY (ENTERPRISE)

Loyalty Configuration in Verifone C-Site Management allows for Loyalty settings to be configured and
managed in the cloud, and then transmitted to a single or multiple sites. Support Loyalty remote
management within the Verifone C-Site Management application requires software Release 54.00 or
higher.

Configuration Syncing

Initial Onboarding

When the Verifone Commander is initially onboarded into the cloud, if it is on Release 54.00 or higher, it will
transmit its current Loyalty configuration to the Verifone C-Site Management application.

The current configuration is only transmitted to the Verifone C-Site Management application during the
initial onboarding.

Configuration Updates

* After the initial upload of the current configuration, any updates made in Verifone C-Site
Management can be accessed and transferred to the site by either the major oil provider and/or the
merchant administrator (if applicable.)

* After the site is onboarded to the cloud, Loyalty Configuration will still be available within Verifone
Configuration Client.

* If there are local changes within Verifone Configuration Client made to the Loyalty Payment
Configuration at the site, these changes will NOT be transmitted to Verifone C-Site Management.

* If updates are sent to the site from Verifone C-Site Management, the last update sent will override
previously transmitted or locally stored data.

Loyalty Programs

The loyalty payment program allows for different loyalty programs to be generated and assigned to multiple
sites with specific Merchant IDs (MIDs) for each location. Loyalty Programs can be created in Verifone
C-Site Management, or they can be added when the site is onboarded to Verifone C-Site Management.

-
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Create Program

1. To create a new Loyalty program, navigate to C-Site Management > Configuration > Site Management
> Select the Sites drop down and switch the view to Enterprise.

st it <—

o et S Hietarchy

Mo ot Socanns Do gl Rockpialier b

2. After navigating to the Enterprise view, select + Create New in the top right corner.

Enterprise - @ Viewing: Loyalty _> <= Create New

Prowvides - Sen riteria m

3. From the Create New Data Set pop-up, select the Configuration Category of Payment Operations.
Select the Configuration Type of Loyalty.

Create New Data Set *
Configuration Category:
I-'a_.-rr-?". l:}r.ﬂ_'ri“'_."_. W

Configuraticn Type

Loyalty w
ﬂ Warning: You will nged Marchant IDUS) to create a progras
7 ™
| Cancel | eI
N A
L -

X
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4. Click Continue to open the creation form.

5. Complete the following parameters shown specific to the Loyalty Program being configured. See table

below for details on each field.

Create Loyalty Program

=

COMM PARAMS & CARD(S)
SETTINGS

| é Back |

Choose a template

@ Create new {7 Clone from existing

General Communication Settings
Parameters

Configuration Name’ |:| Enable Barcode Scan

IP/Host
) |:| Enable Card Download

[ ] Display FEP Inside for Multiple Loyaity

Provider

Heartbeat{seconds)’ [] pisplay FEP Outside for Multiple Loyalty

Receipt Offline Message'

Program Mame

s (
[ ] Ensbie TLS

-
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Field

Create New or
Clone from Existing

Configuration Name

Provider

Program Name
IP/Host
Port

Heartbeat (seconds)

Enable TLS

Program Settings

Receipt Offline
Message

Verifone C-Site Management User Guide

Description

To create a new loyalty program, select the Create New bullet.
To copy settings from another loyalty program to be modified, select Clone from existing. (See next
section for more details)

The specific name for the loyalty provider.

Select the loyalty provider from the list that is used to host the name. The list is a pre-defined
selection of approved loyalty hosts.

Sets the Program ID for the loyalty program.
Sets the IP address of the loyalty host. (Provided by loyalty host)
Communication Port Number for the primary loyalty host (Provided by loyalty host)

Sets the interval in seconds between network status checks from the Electronic Payment Server to
the Loyalty Host. Minimum amount allowed is 120 seconds.

Enables the use of secure Transport Layer Security (TLS) connection to the loyalty host. When TLS is
used, data is encrypted over the communication line.
Enable Bar code Scan - Enables bar code scanning for the related FEP.

Display FEP inside for Multiple Loyalty -Displays loyalty programs at the POS when multiple loyalty is
used.

Enable Card Download - Allows the loyalty host to send down loyalty cards through the Loyalty Card
Table Download function.

Display FEP Outside for Multiple Loyalty - Displays the Loyalty Program at the DCR when multiple
loyalty is used.

When loyalty is offline the message entered here will print on the receipt.

6. Select Save & Next to save the parameters entered.

verifone
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Clone from Existing Program

1. If the Clone from Existing Program is selected on the Create Program form, it will prompt to search for
the name of the program to clone.

Choose a template

Create new () Clone from 8i5ting  ~eqffmm——
Search Configuration

e

2. After completing the search function, select clone or view from the return list displayed.

Choose a template

Create new (®) Clone from exdsting

Search Configuration

L=

Configuration Name Provider Program Name Host Port View Clone
Testing_gat_kyalty PCATS testing_sanity ocalhost 2000 & L
testing_gat_2_piog PCATS testing_qat_2_prog ocalhos 2000 @ L]
Test-gat PCATS Tegt-gat 192 365365 220 & L

3. Enter in the Configuration Name and Program Name for the configuration. Make any additional changes

to the communication parameters and program settings before continuing. See the table above for
more details on each field.

-
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Add Loyalty Cards

1. The next section on the Create Program form allows loyalty cards to be added to the program.

2. If an Alternate ID is allowed with the loyalty card, select the check mark next to ‘Add Alternate ID’. An Alt
ID Card name will be automatically added to the table. Alternate ID cannot be edited, it is only enabled
by being added to the card table.

3. Select ‘Add Another Card’ to add additional loyalty cards to the list.

Altld

Card(s)

Card Name

B ~dd Atternate ID

Abbreviation Lower ISO Upper ISO PAM Length Enabled Edit Remove

AD 0000000000 S909999999 10 &) i

Add Another Card

4. Complete the entry fields for the specific loyalty card being used.

Field
Card Disabled
Card Abbreviation

Lower Iso

Upper Iso

Pan Length

Description
Disables the loyalty card.
Two-character abbreviation for the card.

Sets the lower value of the card bin range. The entered card number must be greater than or equal to
this number to match the table entry.

For standard bar codes and mag stripe loyalty cards this will be the first six-digits.

For GS-128 bar codes, ‘8018’ is a special application ID and is required as the first four-digits of the
Lower ISO range followed by the first two-digits of the bar code.

Sets the upper value of the card bin range. The entered card number must be less than or equal this
number to match the table entry.

For standard bar codes, GS-128 bar codes, and mag stripe this will be the same as the lower ISO
range or ending range value.

Sets the number of digits that are used with each card or barcode.

Mag-stripe loyalty cards use 16-digits. Standard bar codes used 12-digits. GS-128 bar codes use
22-digits.

-
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5. Select Save in the Card window to save the card. Add any additional cards needed for the specific
loyalty program.

6. Select Save & Next to proceed to the Site Assignment Area.

Site Assignment

The site assignment section displays a list of sites that have been onboarded to your C-Site Management

account.

1. Select the sites this loyalty should apply to from the list. Selecting the top level of a group will select all
sites within that group.

2. Select Save & Next after the sites are selected.

COMM PARAMS & CARDIS SITE(S) ASSIGNMENT MIDS REVIEW DONE

Site(s) Assignment

Expand All Collapse AN Select All Deselect A

v i

VIR RiFaH

-
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Loyalty Merchant ID (MID)

Each location must have a merchant ID (MID) assigned to it for the loyalty provider. The MID allows the
loyalty host to identify the site for transactions. Every location will have a unique MID.

Enter in the Merchant ID to the right of each selected location. Be sure to enter in the correct MID for each
site as it is the loyalty provider’s unique identifier for the site.

Service hd Sute bd Site Name Address Merchantld

557850 CLW Q& CLW Q& Mot Presant

There is an optional Bulk Upload feature that allows a spreadsheet to be utilized to import multiple MIDs at
one time.

To complete a Bulk Upload for Loyalty MIDs, select the Bulk Upload button on the form, export the template,
complete the form, and upload the file to the MID section.

MIDs

Tabular wiew

Drag and drop XLS0K file hare

Browse files

-
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Review the Parameters

Before applying the parameters, you can review the selections and entries made to confirm they are
correct. At the bottom of the form, the Card(s) and Site(s) Assignment are collapsed. To expand those
sections, click the title to expand or collapse those sections.

Click Save & Next to apply the configuration.

Review

COMM PARAMS & SETTINGS ~

Configuration Nama

Exampla

Communication Parameters

Provicler Program Name

FIS Exmmple

(-2 =] Port Hearibsat{esconda) TLS

[Tt == 2000 S000 @ Enatls TLS

Program Sattings
[ 'Fratye Barcod= Scan (VP v Comeed Do oo
(=)} Deaclay FEP Inside for Multicle Lovaty =) Diaplay FEP QOutside for Mutiole Lovalty

Rocoipt Offline Meaasnge

this ia teat mag
CARD(S) v
SITE(S) ASSIGNMENT e
 Back

-
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. 61



Verifone C-Site Management User Guide

View Existing Loyalty Programs

1. To create a new Loyalty program, navigate to C-Site Management > Site Management > Select the
Sites drop down and switch the view to Enterprise.

oy u“.h..-'E Farachy

[ T [ D edonbalLor ikl

2. Check the Viewing selection to the right of the filter button. If it is set to Viewing: Loyalty, then use the
Filter function to switch to Loyalty (Configuration Category: Payment Operations | Configuration Type:
Loyalty).

3. Allloyalty programs will be displayed. To search for a specific loyalty configuration, use the drop down
to the left of the search criteria bar to switch between loyalty provider, configuration name, or program
name.

4. Select the three dots to the right of the Program Name view.

5. Click View.
| Enterprise - Viswing: Loyalty = Croade M
N
- (=2
e hguration Name Srancher Bregrarm Mamrs DHast Pt S Mocfied Date *
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VCF 2025 Details

VCF 2025

Communication Parameters Sattings

Frsbin Baroods Scan

Ereabin S Dxwmicnd

Doimplary FEF Inmichs Sosr W) Liryait
Heartbeat (peconde) nol .

Dispelary FER Outsick for Multiohs Loyalty

Aeceipt Gifing Mastage
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1 1 MOoBILE PAYMENT (ENTERPRISE)

Mobile Payment Configuration in Verifone C-Site Management allows for Mobile Payment settings to be
configured and managed in the cloud, and then transmitted to a single or multiple sites. Support Mobile
Payment remote management within the Verifone C-Site Management application requires software
Release 53.41 or higher.

Mobile Payment Configuration in Verifone C-Site Management does NOT set up the Method of Payment
(MOP), touchscreen, and DCRs. For details on how to configure Mobile Payments locally within Verifone
Configuration Client refer to the Mobile Payment Feature Reference guide.

Configuration Syncing

Initial Onboarding

When the Verifone Commander is initially onboarded into the cloud, if it is on Release 53.41 or higher,
it will transmit its current Mobile Payment configuration to the Verifone C-Site Management
application.

The current configuration is only transmitted to the Verifone C-Site Management application during
the initial onboarding. If the Program Name does not exist, then the Verifone C-Site Management
application will create a Program Name and store it.

If a Program Name exists in Verifone C-Site Management that matches the Program Name in the
site’s local Mobile Payment Configuration, VVerifone C-Site Management program will automatically
update the site’s configuration.

Configuration Updates

After the initial upload of the current configuration, any updates made in Verifone C-Site
Management can be sent to the site by either the major oil provider and/or the merchant
administrator (if applicable.)

After the site is onboarded to the cloud, Mobile Payment Configuration management will still be
available within Verifone Configuration Client.

If there are local changes within Verifone Configuration Client made to the Mobile Payment
Configuration at the site, these changes will NOT be transmitted to Verifone C-Site Management.

If updates are sent to the site from Verifone C-Site Management, the last update sent will override
previously transmitted or locally stored data.

-
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Mobile Payment Programs

The Mobile Payment Program page allows multiple mobile payment configurations to be built and assigned
to each site. Each program has a specific individual Program Name. Programs can be created in Verifone
C-Site Management, or they can be added when the site is onboarded to Verifone C-Site Management.

Create Program

1. To create a new Mobile program, navigate to C-Site Management > Configuration > Site Management
> Select the Sites drop down and switch the view to Enterprise.

Enteipie <—

e S Hierarchy ~

Mlissscn St Modaosa Bd "\ Danele Eocketeder B

2. After navigating to the Enterprise view, select + Create New in the top right corner.

Enterprise @ Viewing: Loyaity —3 -+ Create New

Prowvidar w Search Criteria m

3. From the Create New Data Set pop up, select the Configuration Category of Payment Operations.
Select the Configuration Type of Mobile.

X

-
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|-

Create New Data Set

Configuration Categaory

ayment Operasons

Configuration Type:

LA~ bl

b &

>

4. Click Continue to open the creation form.

5. Complete the following parameters shown specific to the Mobile Payment Host being configured. See
table below for details on each field.

Create Program
General Network Other
Adapter Address{IPv4 Format/Domain Name)

VFI Mobile V2w

Program Name

Authentication Type

-- Token— w

Send Loyalty Details

Port

Heartbeat Frequency

--Select— w

S5L Enabled

Outdoor PreAuthorization Timeout(in Secs)

Site Intiated Loyalty

Never Allow Site Entered Loyalty v

Apply changes

6. Select Apply Changes to save the parameters entered.

verifone
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Field

Adapter

Program Name

Authentication Type

Send Loyalty Details

Address (IPv4 Format/
Domain Name)

Port

Heartbeat Frequency

SSL Enabled

Outdoor
PreAuthorization
Timeout (In Secs)

Site Initiated Loyalty

Verifone C-Site Management User Guide

Description

Select the communication standard being used:
VFI Mobile V1 - Connexxus V1 Standard
VFI Mobile V2 - Connexxus V2 Standard

The program name is specific to the Mobile Payment Configuration. This parameter must be unique
as it is the identifier for the Mobile Payment Configuration.

Scan Token - QR Code Generated on the Mobile Payment Application is scanned using the
POS Scanner

Enter Token - Customer or cashier enters a token on the PIN pad.
Display Token - A token for the customer to enter on PIN pad.

Generate Token - Both Display Token and Generate Token display a token on the PIN pad to
be scanned or entered for authenticating the transaction. If a site has different Mobile
Payment programs configured with Generate Token authentication type for all, the customer
is not prompted to select a mobile payment program during the transaction. After selecting
the mobile MOP, the PIN pad displays a @R code instead of a mobile payment programs
election.

Enabling this flag sends SLA/EPS loyalty program details to the Mobile Host Provider.

Host IP or URL (IPv4 Format or HTTP domain name)

Communication Port Number

The time after which the Verifone Commander pings the mobile program host to check connection. If
the host is offline, a mobile host offline alarm message will appear on the POS.

Enables Secure Socket Layer (SSL) for client/host communications.

The DCR pre-authorization time out in seconds.

Select the site-initiated loyalty settings for outdoor transactions:
Never Allow Site Entered Loyalty - Only allows mobile loyalty.
Allow Site Entry i.e., Swiped Loyalty Card- Both swiped and mobile loyalties allowed.

Allow Site Entered Loyalty if no Mobile Loyalty - Allows swiped loyalty is there is no mobile
loyalty.

-
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Edit an Existing Program

1.

6.

To edit an existing Mobile program, navigate to C-Site Management > Site Management > Select the
Sites drop down and switch the view to Enterprise.

Check the Viewing selection to the right of the filter button. If it is not set to Viewing: Mobile, then use
the Filter function to switch to Mobile (Configuration Category: Payment Operations | Configuration
Type: Mobile).

Select the three dots to the right of the Program Name view/edit.
Click View/Edit.

The General tab will display by default. The Sites tab will show which locations have this program
applied.

@ MOBILE TEST Details ®
("Mlb Bulk Uplond‘:\
e

Nosile MOBILE TEST

[ ( Sites |

General Network Other

Adapter Address{IPv4 Format/Domain Name) Outdoor PreAuthorization Timeout{in Secs)

s - P o
(vAmovilev1 ) ( googie.com ) (8o

Program Name Port Site Intiated Loyalty

) (10003 ) ( Never Allow Site Entered Loyelty

\ R
e D [T S——
v ™ = R =
\Somnbion.nivy (60 ) (seconds ~)

Send Loyalty Details M sSLEnabled

After changes have been made to the configuration, confirm that those changes are correct and select
Apply changes in the top right corner of the screen.

@ MOBILE TEST Details ®

( MID Buk Upicad )
Payment Partner ~ —

MoBLE TEST

I. — :I
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Delete an Existing Program

WARNING Deleting the existing program within the Enterprise configuration will delete the

E]@ Mobile configuration from any associated sites.

1. To delete an existing Mobile program, navigate to C-Site Management > Site Management > Select
the Sites drop down and switch the view to Enterprise.

2. Check the Viewing selection to the right of the filter button. If it is not set to Viewing: Mobile, then use
the Filter function to switch to Mobile (Configuration Category: Payment Operations | Configuration
Type: Mobile).

Select the three dots to the right of the Program Name you wish to remove.
Click View/Edit.

Use the Sites tab to see which sites have the Mobile program applied to it.

o o & o

Use the General tab to remove the program, by selecting Remove Program in the bottom right corner of
the screen.

@ Retailer Details ®

( MID Bulk Upicad )
Mobile Retailer

General ': Sites :'

General Other

Adapter Address(IPv4 Format/Domain Name) Outdoor PreAutharization Timeout{in Secs)

- : -~ g B o \
( vAmobilev2 + ) (1921883113 ) (eo ;

Program Name Port Site Intiated Loyalty
g '-I s A R 8 e,
) |\. 443 ) " |\.\Never Allow Site Entered Loyalty )

Tt HoaroestFrecney
¢ )
\ )

- W ~
I\_ 46 .JI \\ Days v ,\

M send Loyalty Details M ssLEnabled
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MID Bulk Upload

MID Bulk Upload feature allows for site specific MIDs to be added in bulk for one specific program. This
feature is useful for onboarding multiple sites within a new Mobile Payment host program.

The MID Bulk upload feature requires the site’s service ID and the site specific MID to be known.

1. To use MID Bulk Upload, navigate to C-Site Management > Site Management > Select the Sites drop
down and switch the view to Enterprise.

2. Check the Viewing selection to the right of the filter button. If it is not set to Viewing: Mobile, then use
the Filter function to switch to Mobile (Configuration Category: Payment Operations | Configuration
Type: Mobile).

3. Select the three dots to the right of the Program Name you wish to remove.
Click View/Edit.
5. Select MID Bulk Upload in the top right corner of the Site selection screen.

(@) MOBILE TEST Details

sk MOBILE TEST

S -

6. Select the
Downloading Excel P —
Template File link on
the Template MID Bulk Upload for MOBILE TEST
Download screen.
After the template is
downloaded, fill in
the Service ID fields 1 St by Downioackng Esnel Tamplaie fin A RN b Okt
along with the el ety o e
associated site
MIDs.

Template Download MID Bulk Report

Last 5 Trarssdbons

Mo records foarsd

7. Save the document
to your computer
and click Continue
on the Template
Download screen.

-
Verlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. 71



Verifone C-Site Management User Guide

8. Either drag and drop the saved Service ID / MID list file into the dotted lines or browser for the files. After
the file is found, select the Upload File button.

MID Bulk Upload for MOBILE TEST

Cipen 8 tempiaie which you hawe Oownicscsd andl 8 § with inlonraton shout your sites. Seve T file snd Lpiosd it Desiow

Drag mred drog NLEK Sis bare

o

9. The screen will return to the MID Bulk Upload form. A “Done” message will appear in the left side of the
screen. To upload more MIDs to the selected program, select Upload Again.

10. To view the result of the upload, select the MID Bulk Report on the left column. The MID Bulk Report will
display the last five MID Bulk Upload results. It is recommended to review the results after the upload to
confirm if the MID was successfully uploaded to the entered Service ID.

MID Bulk Upload for MOBILE TEST

Done MID Bulk Report

Upicad procoss for trensaction MOBILE TEST 03-20-24 2100 ¥ou omn wiew Inst B uploaded transactions here. Chok

Pidis complerted b e L ks v

Uplosal Agan

MID Bulk Report

Invalid Service Id

-
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Primary Payment Configuration in Verifone C-Site Management allows for Primary Payment settings to be
configured and managed in the cloud, and then transmitted to a single or multiple sites. Support Primary
Payment remote management within the Verifone C-Site Management application requires software
Release 55.02 or higher.

Primary Payment Configuration in Verifone C-Site Management does NOT set up the Method of Payment
(MOP), touchscreen, and DCRs. For details on how to configure payments locally within Verifone
Configuration Client, see the Commander User Reference manual.

Primary Payment Programs

The Primary Payment Program page allows multiple primary payment configurations to be built and
assigned to each site. Each program has a specific individual Program Name. Programs can be created in
Verifone C-Site Management, or they can be added when the site is onboarded to Verifone C-Site
Management.

Create Program

1. To create a new Primary Payment program, navigate to C-Site Management > Configuration > Site
Management > Select the Sites drop-down menu and switch the view to Enterprise.

Sy Dl Dirbalafier B

2. After navigating to the Enterprise view, select + Create New in the top right corner.

-
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[ Enterprise «~ | Viewing: Loyalty —> =+ Create New

| Provider ~ Search Criteria

3. From the Create New Data Set pop up, select the Configuration Category of Payment Operations.
Select the Configuration Type of Primary Payment.

F N |
Create New Data Set %
Configuration Category:
| Payment Operations o
Configuration Type:
| Primary Payment o
Form Dependencies:

u Card Price Tiers n Cashback & Fees
| N >

4. Click Continue to open the creation form.

5. Complete the following parameters shown specific to the Primary Payment > Cashback and Fees
being configured. See table below for details on each field.

X

-
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Primary Payment x
] B
CASHBACK & FEES CARD PRICE TIERS SITE(S) ASSIGNMENT REVIEW DONE
Next =

Cashback EBT Cashback Convenience Fee

u Cashback Enabled EBT Cashback Enabled Enable Convenience Fes

u Force PIN Entry Fee Amount

EMV Cashback Prompt - Wait for Cashier?
Cashback Fee
0.00

Field Description
Cashback Enabled Enables cashback on cards. Cashback fee is an added amount to the customer’s transaction to cover

the processing cashback on a debit card.
Force PIN Entry Enforces the customer to enter a PIN.

EMV Cashback Prompt The transaction waits for the cashier to approve cashback on the POS that was entered on the PIN
— Wait for Cashier? pad.

Cashback Fee Sets the Cashback Fee.

EBT Cashback Enabled Enables Electronic Benefits Transfer (EBT) Cashback.

Enable Convenience Enables the convenience fee. Convenience fee is an added amount to the customer’s transaction to
Fee cover the higher costs of processing a credit or debit card rather than using cash or check.

Fee Amount Sets the amount to be used for the Convenience Fee.

6. Select Next to continue to Card Price Tiers.

-
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7. Complete the following parameters shown specific to the Primary Payment > Card Price Tiers being

configured. See table below for details on each field.

*—
Primary Payment *
© 5 - 3 °
Price Tier Configurations
s ARAE ~ s
o du s AN
i e
-
Field Description
Version It is the name given to the Primary Payment Configuration entered in the Review form after the Site(s)
Assignment. The default configuration version is zero.

Select Card Select a card to assign a Price Tier.
Price Tier Assigns “Cash” or “Credit” to the card selected.
Discard Changes Removes recent changes.

8. Select Next to continue to Site(s) Assignment.

verifone
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9. Complete the following Site(s) Assignments shown specific to the Primary Payment being configured.

Primary Payment

Q © Q A4 .

ASHOACK L FET CARD PRSCE THAS SITECS} ASSHINMENT

F

4 Back b ¥

Sitels) Assignment

10. Select Next to continue to Review. Review the following parameters and then click Back if changes are

needed.

-
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11. Enter the name of the Primary Payment Configuration that will be shared across sites.

12. Click Submit.

-
H x
Primary Payment
© A ©
. Fos
- A - °
GASHBAGCK & FEES GARD PRICE TIERS SITE(S) ASSIGNMENT REVIEW DONE
=
Review
Configuration Name’
This name will be shared across configurati c"Ea]‘.
‘: Cashback & Fees :l Card Price Tiers Sitels) Assignment
Cashback EBT Cashback Convenience Fee
Fee Amount
0.00
Cashback Fee
0.00
,v
1 x
Primary Payment
i o,
B — N =] v
CASHBACK & FEES CARD PRICE TIERS SITE(S) ASSIGNMENT REVIEW DONE
Done
Payment Configuration "Test" has been successfully configured!
: H
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Card Price Tiers

1. To edit an existing Primary Payment program, navigate to C-Site Management > Site Management >
Select the Sites drop-down menu and switch the view to Enterprise.

2. Check the Viewing selection to the right of the filter button. If it is not set to Viewing: Card Price Tiers,
then use the Filter function to switch to Primary Payment (Configuration Category: Payment Operations
| Configuration Type: Primary Payment).

3. Select the three dots to the right of the Program Name view/edit.
4. Click View/Edit.

5. The General tab will display by default. The Sites tab will show which locations have this program
applied.

@ Demo Primary Payment Details
Cards Price Tiers

Payment Operations ~
‘ e I
Card Price Tiers

DB - AEMP DEBIT
DB - DEBIT

DB - GASCRD DEBIT
DB - GASPRO DEBIT

DB - MC DEBIT

q Save Changes \ Discard \

6. After changes have been made to the configuration, confirm that those changes are correct and select
Save Changes in the lower right corner of the screen.

-
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Cashback & Fees

1. To edit an existing Primary Payment program, navigate to C-Site Management > Site Management >
Select the Sites drop-down menu and switch the view to Enterprise.

2. Check the Viewing selection to the right of the filter button. If it is not set to Viewing: Cashback & Fees,
then use the Filter function to switch to Primary Payment (Configuration Category: Payment Operations
| Configuration Type: Primary Payment).

3. Select the three dots to the right of the Program Name view/edit.
4. Click View/Edit.

5. The General tab will display by default. The Sites tab will show which locations have this program
applied.

@ Demo Primary Payment Details

Debit Configurations

Cashback & Fees

General
Cashback EBT Cashback Convenience Fee

Cashback Enabled EBT Cashback Enabled Enable Convenience Fee
Force PIN Entry Fee Amount
EMV Cashback Prompt - Wait for Cashier? 4 $ 250

Cashback Fee

[ % 300
Mo

q Save Changes \ Discard I

6. After changes have been made to the configuration, confirm that those changes are correct and select
Save Changes in the lower right corner of the screen.

-
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SITE CONFIGURATION

Site Configuration in Verifone C-Site Management allows for site level price book configurations to be
configured and managed in the cloud, and then transmitted to a single or multiple sites. Support for Site
Configurations remote management within the Verifone C-Site Management application requires software
Release 54.01 or higher.

Site Configurations consists of the information previously located under Store Operations in Configuration
Client.

Configuration Syncing

Initial Onboarding

* When the Verifone Commander is initially onboarded into the cloud, if it is on Release 54.01 or higher,
it will transmit its current Site configuration to the Verifone C-Site Management application.

* The current configuration is only transmitted to the Verifone C-Site Management application during
the initial onboarding.
Configuration Updates

* After the initial upload of the current configuration, any updates made in Verifone C-Site
Management can be sent to the site by the merchant administrator.

* If updates are sent to the site from Verifone C-Site Management, the last update sent will override
previously transmitted or locally stored data.

* Any changes performed on the local site Verifone Commander will sync to the Verifone C-Site
Management.

[jﬁ NOTE A message will be displayed on Site Configuration forms when the Verifone Commander
software release version doesn't support configuring the form.

-
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Site Search
1. Site Configurations are uploaded and managed by each individual site. To search for the specific site,
navigate to C-Site Management > Site Management.
2. Sites can be searched in three ways:

* Searching by site name.

Using the Hierarchy drop-down menu to filter specific groups of sites.

* Paging through the site listings.

75 Sites | Hesrareksy s | earch ity S |
Stone 1 St B Store 14 Sito
— Stors B tore 15 Store 42
Som 3 Storm 10 Slore 16 Stors 43
Etree 4 Stora 11 Srore 17 Shere 44
E1owe 5 Store 12 Sione 18 Slore 45
L] Store 13 Stone 19 Store 46
Fmiuts w
P 5 - - ape 10f § 3
page page

3. After locating the site to view, select it from the list to open the site configurations.

-
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Replicate Configuration

The Replicate Configuration feature allows a site’s datasets to be copied from one location to multiple other
site locations. Support for this functionality relies upon the datasets being present and available in both the
Source Site and the Destination Site(s).

1. Toreplicate a site’s configuration, navigate to C-Site Management > Site Management. Select
Replicate Configuration from the top right corner.

Sites v Replicate Configuration

22 Sites Hierarchy

2. Select a source site from the drop-down menu. The source site must be onboarded to be selected.

rjEJ Replicate Configuration
Aelect & Source Site @

[ gl Rctonse

W Categores B Curencies [l 0CR Configuration
. Fusl finciudes Fusl Prices) . Fusl Prices Inchacies Fusl Products) . Fusl Tax Exarrgalicns
Brw B FOS Secunity I G

B Toh S

Only datasets that are available at the site will appear
as configurations that can be selected.

-
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3. Select the configuration(s) to be copied from the available list. Be aware that if the destination site(s) do

not have the dataset available, they will not appear in the Select Destination Site(s) list.

|i_') Replicate Configuration

Seiect & Source Site

[ April Reloase

[l Catopones

By

B > V¥ Peto Engineering

Only stores that support the configuration will appear
in the Select Destination Site(s) list.

verifone

Tounh Soreen

. CLPOCeS DR Confgunation

[ Fusi inciudes Fusl Prices) Fued Prioes {incluces Fusi Products) [ Fuel Tax Exermptions:

[l PO Secasity I saen
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4. Either search for the site(s) by name using the ‘Search by Name’ field, or use the hierarchy selection
drop-down menu to select the site(s) to copy the datasets to.

@ Replicate Configuration

Select a Source Site °
April Release
Select Configuration(s)

. Biue Laws . Categories . Currencies DCR Configuration
Wrees Fuel (includes Fuel Prices) Fuel Prices (Includes Fuel Products) [l Fue! Tax Exemptions
W vop Wrw |l FOS Security W sales

Tipping Touch Screen

Select Destination Site(s)

w VFA Petro Engineering
6361627
Group1-F
> Texas
» Florida (C

> Nevada

The selected configuration will be sent to 3 site(s)

5. Select Save to complete the transfer to the selected site(s). Changes made to the locations dataset can
be checked within the Site’s configuration page. Selecting Discard will cancel all the options selected
and reset the form.

®
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Store Operations

The following Store Operation
configurations are currently
available under

C-Site Management > Site
Management:

MOP - Method of
Payment

Currencies

Fees

Tax Rates
Categories
Departments

PLU

Blue Laws

ID Checks

Sales

Menu Configuration

Touch Screen

Tipping

Method of Payment (MOP)

Method of Payment configuration allows payments that are accepted at the store to be configured and
modified. Preconfigured MOPs are loaded into the Verifone Commander at the time of installation. MOPs
can only be selected if they are configured on the point-of-sale touch screen or self-checkout. It is best
practice to leave any unused MOP configurations available in case they are needed in the future.

Field

Name

verifone

Description

The record number for the Method of Payment.

Select MOP

2- CHECK

3 - Card Payment
4-DEBIT

5- MAN CRED

6 - IN-HOUSE
7-MAN DEBIT
8- FOODSTAMP

9-LOTTERY

\ 10 - DRIVE OFF

Verifone C-Site Management User Guide

Minimum Amount

z
(000

Tender Code

I generic

Options

W rorce Safe Drop
Tendet Amount Required
. Allow Zero Entry

[ Aiow Refund

Allow Safe Drop

. Force Ticket Print

Nk)w Lottery Purchase

\
\

(000
| O
b

@ | Delete )

MOP Code

) ( o-casH

Maximum Amount

\

#Additional Receipts

Open Drawer on Sale
Cashier Report Prompt

1 Alow Without Sale

Allow Change

. Allow Money Order Purchase

. Force Quick Cash Key

The name of the method of payment is entered here. The name will appear on receipts and reports.

Proprietary + Confidential. © Verifone Inc. All rights reserved.
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The MOP Code defines how the MOP should function. Review the list to determine which MOP should
be used. Selection may vary depending upon the network configuration:

0 - Cash: Used for cash transactions that will be accepted at the POS.

1 - Credit: Used for credit cards sent through the card network. Some reports may show this MOP as
‘Charges’ or by card name.

2 - Debit: Used for debit cards that require a PIN entry prompt on the PIN pad. Tender amount
required should not be selected for this option.

3 - Manual Credit: Used for credit cards not sent through a credit card network.
4 - Manual Debit: Used for debit cards not sent through a credit or debit card network.
5 - Lotto: Used for winning lotto tickets tendered as MOPs.

6 - Check: Used for written checks. If customers are not permitted to write checks for more than the
amount of purchase, do not enable ‘Change Allowed’ setting.

7 - Tax Coupon: Use for product coupons as MOPs. The ‘Change Allowed’ parameter should not be
enabled.

8 - $1 Cash: Automatically enters the tendered amount as $1.00 cash. ‘Tender Amount Required’
should not be selected for this option.

9 - $5 Cash: Automatically enters the tendered amount as $5.00 cash. ‘Tender Amount Required’
should not be selected for this option.

10 - $10 Cash: Automatically enters the tendered amount as $10.00 cash. ‘Tender Amount Required’
should not be selected for this option.

11 - $20 Cash: Automatically enters the tendered amount as $20.00 cash. ‘Tender Amount Required’
should not be selected for this option.

12 - $50 Cash: Automatically enters the tendered amount as $50.00 cash. ‘Tender Amount Required’
should not be selected for this option.

13 - Food Stamp: Used for paper food stamps only. Amounts entered must be as whole dollars for
this MOP.

14 - Drive Off: Used to setup an MOP for clearing fuel sales for customers that drive off without
paying for dispensed fuel.

15 - Special Discount: A MOP used to provide a percentage based discount applied to PLUs and
Department sales enabled for special discounts. See the Special Discount Feature Reference for
more details.

16 - Manual FS: Electronic, non-paper food stamps.
17 - Lottery: Used for scratch-off lottery tickets tendered as MOPs.

18 - In-House: Store credit method of payment used to provide local vendors/customers a store
manage invoicing payment type. See the In-House Account Feature Reference for more details.

19 - Pump Test: Used for testing dispensers. Typically, used during installation of new dispensers and
POS equipment.

20 - EBT Food Stamp: Electronic, non-paper food stamps.
21 - EBT Cash Benefit: Electronic, non-paper cash benefit.
22 - Manual EBT CB: Manual non-paper cash benefit.

-
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MOP Code (Cont’d) 23 - ECheck: Standalone electronic check processing. The balance of the ticket amount is sent to the
host for approval.

24 - Stored Value Card: Used for prepaid stored value cards.

25 - Manual Entry: Selected for manual entry of credit card numbers. Check with the card processing
network to see if this functionality is permitted.

26 - Force Post: This MOP is used when entering transactions that were processed when the host
was offline.

27 - Post Entry

28 - Mobile: Used for Mobile Payment. See the Mobile Payment Feature Reference guide for more
information.

29 - Unattended Refund: Used refunding unattended fuel sales.

30 - Non-Tax Coupon: Used for Product coupons as MOPs. Tax due may be reduced because of
applying this coupon.

31 - Fuel Voucher: Used for fuel vouches (paper) only.

32 - Tax Exempt Voucher: \When applied, the MOP will reduce the amount due based on which taxes

are configured to be exempt. Multiple types of tax exemptions can be configured, and the appropriate
prompts will be presented to the cashier based on the configurations.

33 - Fleet Check: Fleet Checks can be exchanged for cash or be used as MOP in a transaction. See
the Fleet Cards Feature Reference for more information.

Min. Amount The minimum amount accepted by the MOP. (0.00-9999.99)
Max Amount The maximum amount accepted for this MOP (0.00 - 9999.99)
Limit The drawer limit amount is entered in this field. When the limit is reached the POS will prompt the

cashier to perform a Safe Drop. Ensure Allow Safe Drop is selected when a drawer limit is set.

# of Additional Prints additional receipts for the MOP. Force Ticket Print must be selected to enable this parameter.
Receipts Some transaction types and MOPs will print additional receipts regardless of this setting.
Tender Code Used to assign the NACs tender code to Verifone MOPs. Helps to create the NAXML POS Journal

from the transaction log without manually looking up or mapping the tender. The recommended value
is the default values for each MOP. In order to select a new value from the list or enter a new value
other than from the list, delete the default value first.

Tender Sub Code Used to assign the NACs tender code to Verifone MOPs. Helps to create the NAXML POS Journal
from the transaction log without manually looking up or mapping the tender. The recommended value
is the default values for each MOP. In order to select a new value from the list or enter a new value
other than from the list, delete the default value first.

Force Safe Drop Forces the cashier to perform a safe drop before any further sales can be performed on the register.
This selection will automatically enable Allow Safe Drop. A limit (drawer limit) must also be configured
for this functionality to work properly.

Open Drawer on Sale  Opens the cash drawer when the method of payment is selected.

Tender Amount Requires the cashier to enter the amount tendered (cash/payment given) before selecting the method
Required of payment.

Cashier Report Prompt Prompts the cashier to enter the actual (counted) drawer total for this MOP when printing the cashier
report under CSR Functions > Reports > Print Cashier Report.

-
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Allow Zero Entry

Allow Without Sale

Allow Refund

Allow Change

Allow Safe Drop

Allow Money Order

Purchase

Force Ticket Print
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Allows the amount of zero to be entered when entering the actual (counted) drawer totals for this mop
when printing the cashier report.

Allows the method of payment to be used when there are no sales / items rang into the register. For
example, if the MOP was cashing winning lottery tickets, then the customer would not need to
purchase anything in the store.

Allows this method of payment to be used for Refunds.

Allows the cashier to provide change to the customer when the tendered amount is more than the
transaction total. Used for cash transactions and when the store allows cash back for checks.

Allows this method of payment to be used with the safe drop function. If a drawer limit is set, then this
function must be enabled.

Allows this method of payment to be used for the purchase of money orders. See the Money Order
Feature Reference for more details.

Forces the receipt to print at the end of a transaction.

Force Quick Cash Key Allows a set amount to a Speed Cash key using the “00-Cash” MOP code.

Allow Lottery Purchase Allows this method of payment to be used for the purchase of lottery.

-
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Currencies are used to define an alternative currency that can be accepted at the store along with the
exchange rate. Up to two currencies can be configured, with the default currency set to US Dollars.

Field

Name

Symbol

Currency Code

Exchange Rate

Singular Print Name

Plural Print Name

Select Currency

Name Symbol
I./'_—_'\.I I./'_
| USDOLLAR L $
. A .

Currency Code Exchange Rate

Singular Print Name Plural Print Name

ra I,/"
I US DOLLAR ) | USDOLLARS
M > S

Description

The name of the currency. All method of payments uses the default US Dollar currency unless the
Other Currency function (must be added to the touchscreen) is used.

The symbol that will appear on the receipt representing the currency.

The official three letter ISO 4217 currency code. For example, USD stands for US Dollar and CAD
stands for Canadian Dollar.

For the default currency, the exchange rate will always be 1.00000, however when setting a
secondary currency, the exchange rate will be the exchange rate based off the software release /
default currency. For example, the exchange rate for the Canadian Dollar would be entered as $1.32
(According to the July 14th,2023 exchange rate.)

Allows the singular printed name for the currency to be modified.

Allows the plural printed name for the currency to be modified.

-
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Fees are used to charge an additional amount to a department or PLU. Up to 99 different fees can be

added.

Select Fee

2-FEE2
3 - FEE-3-PERCENTAGE
=EEE
- FEE-REFUNDABLE
- FEE2-REFUNDABLE
- BTL DEPOSIT .05 9PK
8 - BTL DEPOSIT .05 10PK
9 - BTL DEPOSIT .05 12PK

% 10 - BTL DEFOSIT .05 15PK

Page1of 3 \

verifone

O o) Field
Name
Name Department

f/- -\'u
( FEE
-

rd "7-\
( 9995-TESTADI ~ )
g v

v

Department
. Fee is Refundable

Range/Amt . Percentage

Fee is
Refundable

Fee Type

Amount

Range

Proprietary + Confidential. © Verifone Inc. All rights reserved.

Description

Enter a descriptive name for the
fee. The name prints on the receipt.

The department assigned here is
where the fee totals will appear in
reports.

Allows the fee to be refunded with
the original sale.

Percentage - Enter a flat
percentage that will be charged for
the department or PLU sale.

Range/Amount - Calculates the fee
amount based on the department
or PLU sale. This fee type uses a
dollar range to determine the fee
amount.

The ending dollar amount for which
the fee will be charged. If left at
0.00, it will default to the maximum
amount allowed by the register.
The starting dollar range for the
first fee is always 0.00. The first
range entry (top right) is from
$0.00 to $xx.xx. The second range
value will start at the next cent of
the previous range.

o1
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Tax Rates

Tax rates configurations allows for up to eight different tax rates to be configured at one location. Tax rates
can be added to departments or PLUs after they have been created to ensure the correct tax amount is
collected on different types of sales.

‘ Select Tax Rate @

Indicator
|'/-_-\'|
I T w o |
. y,

Percent Start

|'/-
( ooo
o

Options
B Frice includes Tax B use Break Point Table

. Use Canadian GST . Prompt For Exemption

Field Description
Name Enter a descriptive name for the fee. The name prints on the receipt.
Indicator Assigns an indicator to the item the tax was added to. The indicator will print out on the receipt to

indicate one or more taxes were applied to specific departments or plus.

Rate Enter in the percentage of the tax rate. For example, if the state tax rate was 7% then the rate would
be 7.
Percent Start The minimum dollar amount that can be taxed. For example, if taxes did not apply to transactions less

than $0.10 then the percent start would be $0.10.
Price Includes Tax Select this option if the price includes taxes.
Use Canadian GST Used for Canadian Goods and Services tax.

Use Breakpoint Table  Select this option if the taxes configured require a breakpoint table. A breakpoint table specifies the
taxable amount for the department or PLU it is assighed based on the cost of the individual line item.

Prompt for Exemption See the Verifone Commander User Reference for more details on Breakpoint Tax configurations.

-
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Categories

Categories are used to group departments for reporting purposes. Categories consist of a number from
1-9999 and a Name. Use the Add button to add a new category or Delete to remove an existing category.

- TG

Select Category

2 - BEER

3 - GENERAL MDSE
4 - CANDY

5 - OTHER TOBACCO
6 - GEN MERCH

7 - SNACKS

8 - GROCERY

9 - HBC/FEC

10 - HABA y

Page1of4 |} :

-
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Departments

A department is a group of similar PLUs/items. For example, the Frozen Foods department may consist of
ice cream, Popsicles, and frozen pizzas. Up to 9999 departments can exist within the configuration. Do not
use Departments 9990-9999 as they are reserved for specific purposes.

Name

.'/-_

| ENERGY SUPP

\-_

3 - COFFEE REFILLS

4 - BUR/SANDYSAL Minimum Amount Maximum Amount
"/- -\II |'/-

5 - FOUNTAIN | 000 ] | 000
S A A

6 - FOUNTAIN REFILL

Product Code Category
7 - HOT DOG/GRILL

421-PACKED BEV NON-ALCO 30-TAXABLE BEV

8 - READ TO EAT |

9 - COOKIES CRACK
Fuel Tax Exemption Transaction Quantity Limit
10 - NUTS SEEDS —_— O

Select Fuel Tax | ooo

11 - MEAT SNACK

Options | |
- Allow Food Stamps . Allow Special Discount

Allow Fractional )
. . Negative Department
Quantity x 1-TEST

Money Order

. Fuel Department
Department

Prohibit Manual

- Prompt Serial Num i
Discount

Field Description

Number Enter in an unused number from 1-9990

Name Enter the name of the department. If items are rung in using the department the name will appear on
the receipt.

Minimum Amount The minimum allowable dollar amount for a line-item sale using this department or an item within this
department.

-
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Maximum Amount

Product Code

Category
Fuel Tax Exemption

Transaction Quantity
Limit

Fees

ID Checks

Taxes

Blue Laws

Allow Food Stamps

Fractional Quantity

Fuel Department

Prompt Serial Number

Special Discount

Negative Department

Money Order
Department

Prohibit Manual
Discount

verifone
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The maximum allowable dollar amount for a line-item sale using this department or an item within this
department.

Assign a product code that categorizes the products sold accurately. Product codes are used by the
card processing network to properly categorize items and may prohibit the sale of certain items for
specific cards. If you are unsure what product code to use for a specific item, contact your card
processing network for direction. Departments MUST have a product code assigned.

Departments can be assigned to categories for reporting purposes. Categories are not required.
Only used by fuel departments that allow a fuel tax exemption to be applied to the sale.

Limits the number of line items per transaction. The default value of 0.00 indicates there are no
restrictions.

Assigns a predefined fee to the department that will be assessed based on the Fee configuration.
Multiple fees can be assigned to a single department.

Prompts for an ID check when a transaction using the specified department is used. Multiple ID
checks can be assigned to a single department.

Charges different tax rates that are selected for the specified department. Multiple taxes can be
assigned to a department.

If the sale of an item is restricted to specific times and/or days, then a blue law can be assigned.
Multiple blue laws can be assigned to the department.

Select this option if the department qualifies for food stamps.

Select this option if items are sold by weight. For example, if the quantity is 1 3/4 Ibs of turkey, then
entering in the value of 175 and selecting a department with fractional quantity enabled will enter in
1.75 instead of 175.

If the Department is used for Fuel, then this option should be selected.

Enable this to prompt for the serial number that is entered by the cashier and printed on the receipt.
For example, if the store is selling electronic devices they may want to prompt for serial numbers or
warranty or return purposes.

Select this parameter if special discounts can be applied to this department.

Select this option if the items rang into this department, are a negative value. For example, a coupon
department would subtract from the transaction total rather than add to it.

If the department is used for selling Money Orders, then this option should be selected. See the
Money Order Feature Reference for more details.

Prohibits discounts configured to be applied using the discount function. This parameter does not
affect PLU promotions, NAXML Promos, or Loyalty line-item discounts.
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PLU or Price Loop Ups are the individual items added to the price book. PLUs may be scannable

(representing a

barcode) or may be assigned to buttons or menus on the touch screen. PLUs can be

created within Site Configuration > Location Name > Store Operations > PLUs. The add and delete button

can be used to

00000000001106/000

create new PLUs or delete the selected PLU from the store’s price book.

BACON

00000000001182/000 MOZZAREL _

Page 2 of 30

Options
[l open
Returnable
Special Discount
[l Fractional Qty

[l Frohibit Manual Discount

Field

Search Description

PLU

Check Digit

B Not Soid
B Food stamp
Promo

[l Prompt Serial Num
Trans Qty Limit

Taxable Rebate(Addition tax added to this PLU when sold)

Description

Use this area to search for the description of an item. The filter icon next to the search description box
allows the search to be filtered by UPC, Description, Department, Product Code, and Price.

The PLU number is the number used to identify the product. The field supports up to 14-digits. If the
item has a barcode, then the PLU will be based on the barcode information. If the item does not have
a barcode, the PLU can be any unused number in the pricebook. PLUs can be assigned to a
touchscreen button, a menu, a key, or entered in manual using the on screen keypad when in sales
mode.

This field will automatically be entered upon saving a new PLU. It cannot be modified

-
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Modifier

Description
Price
Sell Unit

Calories

Department

Product Code

Fees

Taxes

ID Check

Blue Laws

Group ID

Sequence
Trans Qty Limit

Open

Returnable

Special Discount

verifone
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The modifier is used to create a PLU using the same PLU number but allow different pricing points or
PLU configurations to be set. For example, if you sold a 6 pack of soda the barcode would be the
same if you sold them in individual cans. If a modifier is added to the single can or 6 pack PLU, when
scanned the POS will present two options for the cashier to select the correct option the customer is
purchasing. A maximum of 3-digits is supported. If modifiers are not used with the PLU, then this is left
at 000.

The name that appears on the POS, line-item display, and customer receipt to identify the item.
The price of the item.
The smallest unit of a product that is sold to a customer. This is typically left at 1.

Assigns calories to an item to be displayed on the Verifone C18 Self Checkout. If left blank, no calories
will be displayed.

The department is used to group PLUs and is a required field for PLUs. Select the drop-down menu to
assign the appropriate department to the PLU. If one does not exist, refer to the previous section to
create a new department for the item.

Assign a product code that categorizes the products sold accurately. Product codes are used by the
card processing network to properly categorize items and may prohibit the sale of certain items for
specific cards. If you are unsure what product code to use for a specific item, contact your card
processing network for direction.

Assigns a predefined fee to the department that will be assessed based on the Fee configuration.
Multiple fees can be assigned to a single PLU.

Charges different tax rates that are selected for the specified department. Multiple taxes can be
assigned to a PLU.

Prompts for an ID check when a transaction using the specified department is used. Multiple ID
checks can be assigned to a single PLU.

If the sale of an item is restricted to specific times and/or days, then a blue law can be assigned.
Multiple blue laws can be assigned to a PLU.

The group ID to which the PLU belongs. When one of the items in the group is scanned, the system

will allow the cashier to select from a menu of the grouped items. The selected item is added to the
ticket, which may not be the original item scanned. This feature only works if enabled within System
Properties at the store level.

The sequence number is used with the Group ID to determine the order of the PLU in the group.
Limits the quantity of the item that can be sold in a single transaction.

When enabled, allows the price to be entered when the item is sold. Creates a PLU that functions like
a department sale but can be used to be more specific.

Determines whether the item can be returned to the store by using the refund function on within sales
mode on the POS. If the item is not returnable, then deselect this option. It is enabled by default.

Select this parameter if special discounts can be applied to this PLU.
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Fractional Quantity

Prohibit Manual
Discount
Not Sold

Food Stamp

Promo

Prompt Serial Number

Taxable Rebate
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Select this option if items are sold by weight. For example, if the quantity is 1 3/4 lbs of turkey, then
entering in the value of 175 and selecting the PLU with fractional quantity enabled will enter in 1.75
instead of 175.

Prohibits discounts configured to be applied using the discount function. This parameter does not
affect PLU promotions, NAXML Promos, or Loyalty line-item discounts.

Select this option if the PLU cannot be sold within sales mode, but still needs to remain in the price
book for reporting purposes.

Select this option if the department qualifies for food stamps.

The promo options allows the PLU to be used within a PLU Promotion. This option is enabled by
default. If the item isn’t set up within PLU Promotions, then it will not apply any promotion.

Enable this to prompt for the serial number that is entered by the cashier and printed on the receipt.
For example, if the store is selling electronic devices they may want to prompt for serial numbers or
warranty or return purposes.

The rebate amount and taxes that are applied to the rebate amount can be assigned here. Taxable
Rebate must be enabled within Sales Configuration > Enable Receipt Tax Detail.

Taxable Rebate{Addition tax added to this PLU when sold)

Rebate Amount

-~

!
I\. 0.00

e,

-
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Blue Laws

Blue Laws prohibit the sale of
certain items during specific Select Blus Law
days and times. Blue Laws (uetaws-1 )
are dependent upon local
government laws/

regulations. Sunday
Up to two blue laws can be
. Monday
configured.
Tuesday
Wednesday
Thursday
Friday
Saturday
Adding a Blue Law

1. Select the Blue law from the drop-down list in the top left corner.
2. Select the days of the week the blue law applies.

3. Enter in the start and end times for the blue law. Times are entered based on military time. There are
two start and end times that can be used in the event the blue law starts at midnight and ends in the
morning, but then starts again in the afternoon.

Values can be copied to different days of the week by selecting the three dots to the right of the End 2
time. The change applies to the selected day of the week immediately upon selection.

-
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Select Blue Law

I: Blue Laws -1 .l.
\_ /

Sunday (o1 EHED {00 ):(00) (00 ):(00)

Copy values to
Monday

Thursday :I

r,
—

) il el - - Reset
Tuesday (o1 L2 59 ) (00 00 ) A

[ [ETT A —— o -0 nn Y

4. Blue Laws can be assigned to Departments and PLUs after they are created.

-
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ID Checks

ID Checks allow the point of sale to prompt the cashier to collect the customer’s ID information to confirm
they are old enough to purchase the product. There can be up to six different ID Checks configured. See the
Age Restriction Feature Reference Manual for more information on ID Check configuration.

Select ID Check ( Delete )

2 - TOBACCO ID CHECK

g
3 - Force scan ID check I ALCOHOL ID CHECK
.

4 - Manual entry overrid

Bypass ID Check B Force scan/swipe Only
5 - ID legitimacy check

5 miktary Security Level Perform ID Legitimacy Check

Manual Entry Override

Confirmation Prompt Security Level

' \
':. | confirm age is legal ) v
o -

Online Age Verification

Exceptions

B wiitary B pate Basea
Minimum Age Minimum Age

yyyy-mm-dd

./-
( 1970-01-O01
S

Field Description

Name The name of the ID check will be entered here.

Age The minimum age of the customer who can purchase the item. The date calculation is based off the
local Verifone Commander’s date and time settings.

Bypass ID Check If this parameter is enabled, it allows the cashier to skip the ID Check and confirm the customer is
allowed to purchase the item. If the cashier does not select confirm, then the item is not added to the
transaction.

Security Level This setting is used with the Bypass ID Check field. The security level field sets a security level for the

Bypass ID function. For example, if the security level was set to 7 then POS users with security level of
7 would be able to use the Bypass ID check function.

-
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Force Scan / Swipe

Only

Perform ID Legitimacy
Check

Manual Security
Override

Online Age Verification

Exceptions
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This setting is used with the Bypass ID Check field. It will prompt the cashier to accept the
confirmation prompt that the customer is permitted to buy the item.

When Force Scan/Swipe Only is enabled, the cashier is not allowed to enter the details manually.

A bar code scanner or magnetic strip reader (MSR) captures birth date information from the ID card’s
bar code or magnetic stripe. The collected information will perform an automated mathematical
check to ensure the consumer meets the minimum age requirement to approve the transaction.

If the consumer is below the minimum age requirement, the transaction will not complete.

This setting is used with Force Scan/Swipe Only. A bar code scanner or MSR captures at least two
pieces of personal information from the ID card’s bar code/magnetic stripe and temporarily display
them to the clerk on the POS screen.

* Piece of personal information #1: ID Card Full Name

* Piece of personal information #2: License Number

The cashier compares the information displayed on the POS screen with the information on the
physical ID. If there is no mismatch the cashier can approve the transaction, or they can decline the
transaction if there is a mismatch between the information presented.

This setting is used with Force Scan/Swipe Only. When selected, a POS user with a high enough
security level can manually enter ID details even when ‘Force Scan/Swipe Only’ is selected.

The Security Level drop-down menu below this option is the security level set for Manual Security
Override.

Enable for TruAge Digital ID verification. Additional settings are needed for this functionality to work.
See the Age Restriction Feature Reference for more details.

Military and date-based exceptions can be configured for each ID Check.

Military Exception - After manual entry of the date of birth (DOB) from the ID, if the DOB fails standard
minimum age limit check, but passes military minimum age limit test, a prompt will appear for the
cashier to confirm if it is a military ID.

Date Based or Grandfather Exception - Grandfather age check is based on a past minimum age
requirement. If the DOB check meets this secondary date-based exception, the transaction can be
completed.

-
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Sales

Sales Configuration

The sales configuration form is used to configure sales functions such as Print Receipt, Force DOB on ID
Check, Error correction Security level, and other sales related functions.

E——

Selact Sales Configuratson

Canadian GST

Cardioad Rechange Dept

Cash Drawers Connected

Cash Undar Rurn Autd Refund
Check Drawer Amount On Safe Drop
Count Undermun Customers

Diesabile Error Comect Key

Discount Denomination

Descount Typa - Pot or Amt

Field Description

Allow Amount Entry for Allows amount entry for refund so that the cashier can give the amount entered as refund to the

Refund customer as a roundoff figure after taking the difference from the customer.

Canadian GST Select if the site collects Canadian GST tax. Special prompts for Canadian GST appear in the Tax
Rate File.

Cardload Recharge Select to assign the department number for cardload recharge.

Dept

Cash Drawers Allows the number of cash drawers connected to the POS to be increased from one to a maximum of

Connected two cash drawers. Connecting two cash drawers allows two cashiers to utilize one point of sale, while

keeping their drawer totals separate.

Cash Under Run Auto  If disabled, cashier must complete the underrun transaction by selecting a MOP. If enabled, when
Refund cashier claims the fuel sale, amount is automatically refunded.

-
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Check Drawer Amount Select to compare the amount of the MOP entered to the calculated amount currently in the cash
on Safe Drop drawer.

Count Underrun When a cashier completes a prepay underrun transaction, the underrun customer count is
Customers incremented in the Summary Report, Shift Report and Daily Report with the attribute “Underrun
Customer”.

Disable Error Correct ~ “Error Correct” button is not displayed on the POS touchscreen when this parameter is enabled.
Key

Discount Denomination Refer to Discount Denominations in the Verifone Commander User Reference for configuring
discounts.
Select so that when the cashier selects the discount key (hard key, soft key, or touch-to-modify
menu), any configured discounts are displayed as part of the discount overlay.

Discount Type — Pct or Select the type of discount to apply when the Discount function/button is used.

Amt Percent — The discount is calculated as a percentage of the price and then subtracted from the price
of the item.

Amount — The Discount is directly subtracted as a dollar amount from the price of the item.

Display PLU Not Found Select to set a department number to assign to PLUs that are not in the PLU department list.
Department List

Drawer Alarm Timer Enter the number of seconds a cash drawer is allowed to remain open before an alarm is triggered
(0-99). “Drawer Open During Sale” must not be selected for the drawer alarm time to work.

Drawer Open During Allows the cash drawer to remain open during transactions. If it is not selected, the cash drawer must

Sales be closed before the next transaction can be started.
Employee Number Allows a cashier to login using their Employee Number instead of their POS ID humber. The employee
Login number is assigned within Security > POS Security > Employees. \When enabled all employees must

login with their employee number.

Enable Auto Settle Select to determine whether to apply a charge on a prepaid sale in case of an overrun. When enabled,
Overrun the overrun amount should automatically be settled to “Drive Off” MOP to complete the transaction.
Enable Managed Enable to provide an interim approval step during the PLU file update process and to allow updates to
Update take effect within the POS system immediately upon approval. No restart required after approval.
Enable Receipt Tax Enable to print the tax details on the receipt. Even if this feature is disabled, if there is a taxable rebate
Detail in the transaction, the tax details are printed on the receipt.

Error Message Prompt Enter the length of time (in seconds) that error messages display (2 - 30).
Timer

Fixed Discount Rate If “Is Fixed Discount” is selected, enter the percent or amount (set in “Discount Type”) that is
automatically applied when the Discount button is pressed.

Food Service Default  Not Used.
PLU

Force DOB on ID Check Select to force ID checks by displaying messages, beeping, and restricting sales until a birth date is
entered, scanned, or swiped.

-
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Force No Sale Print
Force Refund Print

Force Void Line Print

Force Void Transaction

Print

Fuel Discount

Fuel Discount Title

Idle Prompt Displays
Due Sale

Is Fixed Discount

Is cashier # required for

each sale
Is subtotal required
Is total in double

Maximum Amount
Maximum Discount
Maximum Quantity
Maximum Till
Transaction Amount
Minimum Amount

Minimum Discount

Money Order Low

One Cashier Per
Drawer

Open Drawer Cashier
Close

verifone
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Prints a receipt for any No Sales that are completed.
Prints a receipt for any Refunds completed.
Prints a receipt for any transactions that contain a Void Line.

Prints a receipt for any transactions that were Voided.

Enter the dollar amount per gallon discount that is applied when a fuel discount key is used (0.00 —
99.99).

To rename Fuel Discount with a descriptive name, enter up to 30 characters.

Not Used.

Select to automatically enter discounts (set in “Discount Type” as a percent or amount) for the
amount entered in “Fixed Discount Rate” when the Discount button is pressed. If it is not selected all
discounts must be entered as individual amounts.

Select to require the cashier/employee number and password before starting each sale.

Requires the cashier to select the Total button before the Method of Payment (MOP) can be selected.
Prints the transaction in Double-Wide characters on the Receipt.

Enter the maximum amount that any one department item may cost if ‘O’ is entered for Department >
Maximum Amt (0.00 — 9999.99)

Enter the maximum discount (either percent or dollar as set in “Discount Type”) that can be applied to
an item when using the Discount button (0.00 — 99.99).

Enter the maximum quantity of any one item that may be sold in one transaction (0.00 — 9999).

Enter the maximum transaction amount.

Enter the minimum amount that any one department item may cost if ‘O’ is entered for Department >
Min Amt (0.00 — 9999.99).

Enter the minimum discount (either percent or dollar as set in “Discount Type”) that can be applied to
an item when using the Discount button (0.00 — 99.99).

Enter the number of checks remaining before an alarm message indicates that the money order
machine needs to have more checks loaded (O - 99). Refer to the Money Order Feature Reference for
more information on this feature.

Select to limit login to one cashier per cash drawer until totals are closed. This can be overridden by
personnel with higher security levels than the cashier. If not selected, more than one cashier is
allowed per cash drawer.

Select to close open drawer before another cashier can use the cash drawer.
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PLU Not Found
Department

Prepaid Card Activate
Department

Prepaid Card Recharge

Department

Prevent Modify Key
Cycling

Print DOB on Journal
Print DOB on Receipt

Print Receipt
Print UPC on Receipt

Prompt Dine In

Prompt Food Order
Name

Prompt Food Order
Phone #

Prompt Loyalty for PLU
Not Found

Receipt Print PPG
Discount Table

Receipt Print Program
Name

Register Time-Out
Timer

Release Terminal
During Close

Reminder to Use
Imprinter

Reset Display on
Drawer Close

Reset Display on
Timeout

verifone
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Enter a department number to assign to PLUs that are not on the PLU File and are entered as a sale
(0 — 9999). Entering a value of 0000 disables the department not found function. The department
record must be available within the Department configuration.

Enter the department number for prepaid card activation sales transactions.

Enter the department number for prepaid card recharge sales transactions.

Not Used.

Select to print DOB on journal logs.
Select to print DOB on receipt.

Select to print a receipt for every transaction (if not selected, a receipt will only print for No Sale, Pay
In, Pay Out, Clock In/Clock Out, Void, Car Wash, POP Discounts, Credit Transactions).

When this feature is enabled, the actual UPC or PLU will be printed on the receipt, along with the
description.

Select to prompt dine in for food orders.

Enable to prompt for entering customer name for food orders.

Enable to prompt for entering customer name for food orders.

When enabled, if a scanned bar code or manually entered number comes as “PLU Not Found”, the
system asks the user if the number is a Loyalty Card.

Enable to print clearer breakdown of discounts on the fuel receipt. This includes pop, loyalty, and any
other discounts taken off fuel prices.

Receipt prints loyalty program name.

Enter the number of minutes (001 — 999) after which an idle terminal automatically switches out of
Sales Mode. Entering 000 indicates that an idle terminal will not log out of sales mode.

Select to allow the terminal to return immediately to Sales mode after a close shift or close daily is
started.

Not Used.

Idle sales message returns when the drawer closes.

Enter the time (in seconds) before the idle sales message returns to the operator display after a
transaction is complete. When “Reset Display on Time-out” is selected, a value must be entered here
(2 —3600). 1 =2 seconds. O disables the option to reset display on time-out.
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Stack Manual Discount If enabled, multiple manual discounts can be applied on a line item. Cannot apply multiple discounts if
item has NAXML discount applied to it.

Store Number Enter the number or name that identifies the store. This information is printed on receipts and reports
(alphanumeric, 1 - 5 characters).

Value Added Tax (VAT) Select if value added tax (VAT) is collected at the site. Special prompts for VAT appear in the Tax Rate
File (U.S. and Canadian sites usually do not collect VAT).

NOTE
[jﬁ See the Verifone Commander User Reference in the event the function is not listed above.

-
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The Sales Login/Logout Messages
display a message when logging in or
out of sales mode for the cashier to
review. The messages only appear at
the time of logging in or out of sales.

Messages will appear for all cashiers.
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.:: Sales Configuration Login/Logout Message

Login

Show Log-in Message

Line 1
I: REMEMEBER TO ASK IF CUSTOMER IF THEY WANT
Line 2

I: TO USE THEIR LOYALTY CARD!

o

Line 3

Log Out

Show Log-Out Message

Line 1

|: Please settle the
Line 2

I:r Suspended Transactions

S

Line 3

-
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Menu Configuration

[jﬁ NOTE Menu Configuration is read-only and requires Verifone Commander 56.00.00 Release
Version.

Use Store Operations > Menu Configuration to view the menus.

The Menu Configuration form allows the ability to view PLU items in menus and menus that are linked
together in menu chains / order menus. Menus are assigned to the POS touchscreen, Self Checkout
touchscreen, or to the register keyboard if one is used.

The Menu Selector displays a list of existing menus sorted in the order of their Menu ID number. The menu
selector displays the Menu ID number, Menu Name, and any Notes.

The note field displays additional information about the menu for configuration use only. The note is
displayed in only in areas of the configuration such as menu configuration, touchscreen configuration,
self checkout configuration, etc. Notes appear in parenthesis to the right of the description.

Express Manu

Pagalof 4| >

FluUs 4— Menu Items

Crrzprlny Mame
COO0O0D0CNS0TAD00 BASIC WASH
DOO0O000MEN2AND00 DELLNE WASH

DO00DOO0IS055/000 WORKS WASH

-
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Search Menus
Menu Selector

Number
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Type
Note

Parked

Menu ltems

Filters
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Description

Select the menu type. These are the menu types:

Expanded Menu — Displays several PLUs and allows only one PLU to be selected. The menu clears
after one selection. It is also known as single-select menu.

Multi-Select Menu — Displays items in the menu until “Done” is selected.

Express Menu — Displays six items in an overlay or pop-up and the menu clears after one selection. It
was previously known as Ruby menu.

Menu Chain and Order Menu — Both these menu types can be assigned one or more Expanded or
Multi-selector Express menu types and when selected, leads to the other menus.

In the Order Menu, all menus are added as sub-items and treated as a single line item in the ticket.
When voided, entire order will be removed from the ticket.

In the Menu Chain, each menu item is added as a separate line in the ticket and each item must be
voided separately.

The search menus field is a context sensitive search field that allows menus presented in the menu
selector to be easily searched.

The menu selector displays the Menu ID number, Menu Name, Menu Type, and any Notes when used.
The menu selector displays a list of existing menus sorted in the order of their Menu ID number. The
user can go forward or backward through the selections.

Displays the menu number.
Displays the name of menu that will appear on the POS or Self Checkout.
Displays the type of menu.

The note field is used to add additional information about the menu for configuration use only. The
note is displayed only in areas of the configuration such as menu configuration, touchscreen
configuration, self checkout configuration, etc.

It indicates if a menu is used in the parked menu panel of the POS screen. This option is not available
for menu chains and order menus.

Displays the PLUs in a menu with the number, UPC, display name and image.

Menu items can be filtered by UPC or name. The search can contain or not contain certain numbers or
characters.

-
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Touch Screen
NOTE
Touch Screen requires Verifone Commander 56.00 release version.

Use Store Operations > Touch Screen to configure the screen panels. The Touch Screen is divided into
three sections:

* Panels — The area within a screen with these panels is collectively referred to as User Panel.

* Screens — Each screen has a name and can be configured to have up to three panels. All screens
appear as tabs on the register. A screen can have only one fuel panel and one parked menu panel.
Also, only one fuel panel and parked menu panel can be assigned to a POS register, but these fuel
panels and parked menu panels can be included in multiple screens on the register.

» Registers — Each Register or POS can be configured to have one or more screens.

Panels Configuration

Use Store Operations > Touch Screen > Panel Configuration to configure panels and to configure items
assigned to panels.

Panels have the following types:
* |tem Panels
* Parked Menu Panels
* Fuel Panels

¢ Fuel Details

-
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Use Item Panels form to configure panels that have PLU, Department, MOP, Function or Menu Key items.

Panels
ltem Panels

Preview:

PiZZA
123

Field

Search Item Panel
Edit Panel

Select Item Panel
Delete

Copy

Add

Preview

Assigned Screen(s) : None

Description

Search for an existing item panel.

Edit a selected panel

Select the item panel to be edited, deleted, or copied.
Delete a selected item panel.

Copy a selected item panel.

Add a new item panel.

Preview the buttons on an item panel.

-
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View or edit an item panel
Click on Edit Panel.

ltem Panels Parked Menu Panels
Edit Panel

Assigned Screen(s) : None

Preview:

PIZZA
123

Apply Changes

-
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View or edit an item panel (Continued)

View / Edit Panel

Tt fairs Al ety ltem Properties

. Inactive

PIZZA
123

@@ NOTE New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Field Description
Delete Item Select and delete an item from the panel.
Add Item Add an item to the panel using the ltem Properties on the right side.
Name Name of the panel.
Platform Platform or POS used.
No of Rows Number of Rows used on the panel.
Utility Panel Check the box if this is a Utility Panel.
. $
°® -
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Item Properties Use to edit existing items or assign properties to new items.
Inactive - It defaults to inactive.

Item Type - Sets the item as a function, department, MOP, Menu, PLU, or Monitor. The next value
input is assigned based on the item type.

Line 1 - Enter eight alphanumeric characters.

Line 2 - Enter eight alphanumeric characters.

Text Color - Enter the Hex Color Code for the button label.
Background Color - Enter the Hex Color Code for the button color.

Item Position - Use the arrows to move the item around on the panel. Alternatively, use the mouse or
mouse pad to drag and drop the item into a different location on the panel.

Also, the user can drag and drop the buttons as well from the screen.
Discard Remove any changes made to this form.

Save Save all changes made to this form.

-
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Parked Menu Panels
| Registers

Parked Menu Panels ( Fuel Panels

Select Parked Menu

I:‘ Discard I_I Apply Changes

@@ NOTE New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Field Description
Search Parked Menu  Search for an existing Parked Menu.
Select Parked Menu Select a Parked Menu for editing.

Assigned Register(s) Register or POS terminals assigned to the Parked Menu.

Select Menu Add a menu to a Parked Menu.

Text Color Enter the Hex Color Code for the button label.
Background Color Enter the Hex Color Code for the button color.
Delete Delete a selected Parked Menu.

-
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Add Add a new Parked Menu.
Preview Text Displays a preview of the menu button colors.
Copy Select a Parked Menu the list and make a copy of it.
Discard Remove any changes made to this form.
Apply Changes Save all changes made to this form.
®
. [ ]
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Fuel Panels
@ | Screens Registers |
( temPanels ) ( Parked MenuPancis | (STCECEOCEN ( Fuel Detais )

Assigned Register(s) : Default, 103, 104

Details

Starting Fuel Point

@@ NOTE New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Field Description
Search Fuel Panel Search for an existing Fuel Panel.
Select Fuel Panel Select a Fuel Panel for editing.

Assigned Register(s) Registers or POS terminals assigned to the Fuel Panel.

Select Menu Add a menu to a Fuel Panel.
Delete Delete a selected Fuel Panel.
Copy Select a Fuel Panel the list and make a copy of it.

-
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Add Add a new Fuel Panel.
Starting Fuel Point Enter the fueling point number where the fuel points should start on the fuel panel.
Number of Fuel Points Enter the number of fueling points for the fuel panel.

Fuel Point Assignments Use the mouse or mouse pad to drag and drop the fuel points into a desired order.

Reset Click to set the fuel point assignments to the default order.
Discard Remove any changes made to this form.
Apply Changes Save all changes made to this form.

Fuel Details

Select Prepay Profile Assigned Register(s) : 103

Copy of test
Fuel Prepay Buttons

) Apply Changes

Field Description

Search Prepay Profile  Search for an existing Prepay Profile of Fuel Prepay Buttons.
Select Prepay Profile  Select the Prepay Profile to edit.

Assigned Register(s) Registers that are assigned to the selected Prepay Profile.
Fuel Prepay Buttons Create preset buttons for certain amounts.

Discard Remove any changes made to this form.

Apply Changes Save all changes made to this form.

-
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Screens Configuration

Each screen has a name and can be configured to have up to three panels. A screen can have only one fuel
panel and one parked menu panel, but these fuel panel and parked menu panels can be included in multiple
screens on the register.

Field

Search Screen
View/Edit Screen
Select Screen
Assigned Register(s)
Display Name

Panel Assignment
Delete

Copy

Add

Assigned Registerds) - Default, 104

Panel Assignment

Description

Search for an existing created screen.

Use to view or edit an existing screen from the selected screen on the left side.
Select the screen to edit.

Registers that are assigned to the selected screen.

Displays the name of the screen on a tab to the cashier.

Displays up to three panels with panel types and item panels.

Delete a selected screen.

Copy a selected screen.

Add a new screen.

-
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Add a New Screen

To add a new screen, click Add.

| Repgisters

Add Screen

Panel Assignm

Panel Type

Fuel Panel
lterm Panel

Parked Menu Panel

-
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Field
Screen Name
Platform
Utility Panel
Delete Panel

Add Panel
Display Name

Panel Assignment

Panel Type

ltem Panel Selection(s)
Discard

Save
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New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Description

Give the new screen a name.
Platform or POS used.

Check the box if this is a Utility Panel.
Delete the selected panel.

To add a panel, click Add Panel and then use the Panel Assignment to the right on the screen. There
can only be three panels per screen.

It is the name of the screen that displays as a tab to the cashier on the POS. The cashier can switch
back and forth between tabs.

It configures the panel by type. Panels can be moved using the mouse or mouse pad.

The panel type can be configured by Fuel Panel, ltem Panel, or Parked Menu Panel. There can only be
one Fuel Panel and one Parked Menu Panel.

After selecting Item Panel for Panel Type, select the items.
Remove any changes made to this form.

Save all changes made to this form.

-
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View or Edit an Existing Screen

Click on View/Edit Screen on the Screen main form.

. 'eW/Edit Screen

Asmgned Res ) - Defautt. 104

Panel Assignment

-
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View or Edit an Existing Screen (Continued)

Vienas ! Eciit Scresn

P b P

CAR WASH

g

Field
Screen Name
Platform
Utility Panel
Delete Panel
Add Panel

Display Name

Panel Assignment

Panel Type

FLEL Tox
FENT

] _ Canck

Tioksd
Fumtane

. N
COHICIEN BLY
. - --ﬂm

New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Description

Select the screen to be viewed or edited.
Displays POS platform.

Check the box if this is a Utility Panel.
Delete the selected panel.

Not used.

It is the name of the screen that displays as a tab to the cashier on the POS. The cashier can switch
back and forth between tabs.

It configures the panel by type. The user can also drag and drop panels.

The panel type can be configured by Fuel Panel, Item Panel, or Parked Menu Panel.

-
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Registers Configuration

Use the Registers Option to assign fuel options and screens to each POS or register.

Options

Assigned Register(s) : None

Copy of Test
Fuel Options

Zoned Fuel Control
Allow One-touch Approval

Allow One-touch Claim

I' Discard 'I Apply Changes

Field Description
Search Option Search for an option that has fuel options assigned to it.
Select Option Select the option to view or edit.

Assigned Register(s) Registers that are assigned to the selected option.

Fuel Options These Fuel Options assigned to an option:
* Zoned Fuel Control - This function disables the approve all functionality.

* Allow One-Touch Approval - Allows the cashier to touch a fueling icon just once to approve a calling
fueling position.

* Allow One-Touch Claim - Allows the cashier to touch a fueling icon just once to claim a due fuel

sale.
Discard Remove any changes made to this form.
Apply Changes Save all changes made to this form.

-
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Configurations

Configurations

Field

Search Resister
View/Edit Register
Select Register
Assigned Register(s)
Display Name

Panel Assignment
Delete

Copy

Add

View/Edit Register

Description

Search for an installed register or POS.

Use to view or edit an installed register or POS from the selected register on the left side.
Select the installed register or POS to edlit.

Registers that are assigned to the selected screen.

Displays the name of the screen.

Displays up to three panels with panel types and item panels.

Delete a selected screen.

Copy a selected screen.

Add a new screen.

-
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View or Edit an Existing Register

Click on View/Edit Register or POS on the Register main form.

View/Edit Register

0 -8
102 -Cce
103 -Cha
104 -8
106-C18
106 - 18
107 -8
108 -8

\_109-C18

-
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View or Edit an Existing Register (Continued)

View / Edit Register

Tab Screens can be dragged and
dropped in a desired order.

Platform : C18 || Utility Panel

Lottery Lottery GROCERY GROCERY
Scratch Payout TAX NO TAX

DESSERTS

BACONEGG
CHEESE
MUFFIN

SIDES

SAUSAGE
EGG CHEESE
MUFFIN

CARWASH

FUEL TCK
Lottery SODA

CHICKEN

FOUNTAIN _
SANDWITCH 123454

CROSSANT

BISCUT 3 BACON SAUSAGE E-CIG
HAM SIDE
SIDE SIDE SIDE DEVICE

E-CIG

Don

CHEESE

o

ITALIAN { Bakery CHOOSE
FOUNTAIN CHICKEN

AvenCE Doz ominen

]

Field

Register Name

Copy To

Tabs

Platform

Utility Panel

Screen Selection

New functionality has been added in conjunction with Verifone Commander Release 56.00
where the user can use drag and drop with panels, buttons, and screens.

Description
Select the Register to be viewed or edited.

Copy the selected register's touch screen configuration to another installed register or POS. Do not
use the default register.

These are displayed to the cashier and added using the Screen Selection drop-down menu on the left
side.

Displays POS platform.
Check the box if this is a Utility Panel.

This function adds screen tabs to allow the cashier to switch back and forth between screens.

-
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Fuel Panel Select and add a fuel panel from the drop-down menu to the screen. A screen can have only one fuel
panel.
Parked Menu Panel Select and add a parked menu panel from the drop-down menu to the screen. A screen can have only

one parked menu panel.
Fuel Details Panel Select and add a Prepay Profile from the drop-down menu to the screen.

Fuel Options Select and add a Fuel Options profile from the drop-down menu to the screen.

-
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Tipping
The Verifone Commander now provides flexible tipping options for sites that sell prepared items. The
tipping prompt will be displayed on the PIN pad. Preset amounts or percentages for customer selection will
be configured in Verifone C-Site Management. The “Prompt for Tip” will be enabled in the department and

will apply to all PLUs within that department. Customers will have the option to enter a custom amount. The
prompt is customizable.

Tipping requires Verifone Commander 56.01 release version.

NOTE See the Tipping Feature Reference on how to configure the Tipping feature on Verifone
C-Site Management.

The Tipping Feature can only be configured on Verifone C-Site Management. It is not
available in Verifone Configuration Client.

Prompt Configuration

Enabie Tipping

Customer Prompt

AddaTip?

Dispiay By

w Display Customn Amount Desplay No Tip

-
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Payment Operations

To configure Loyalty, Mobile Payment, or Primary Payments at a site, navigate to C-Site Management >
Configuration > Site Management and select a site. Use the following sections to configure the Payment
Operations.

Bites Frpdcats Cor fguraton
27 Sites Porarchy
Mission 51 Modanna Rd Renolr Rockefeter Blvd

X

-
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Loyalty Sales allow the processing and redemption of loyalty transactions, both inside at the Point of Sale
(POS) and outside at the Dispenser Card Readers (DCR). Each locations loyalty configuration can be viewed
and modified for individual sites. The individual site configuration for loyalty is found under C-Site
Management > Site Management > Site Name > Payment Operations > Loyalty.

Complete the following parameters shown specific to the Loyalty Host being configured. See table below
for details on each field.

Parameters

1: PROGRAMO1

PROGRAMO1

General

() FEP Enabled

Provider

Field
FEP Enabled

Provider

Merchant ID

Communication Parameters Settings

IP/Host . Enable Barcode Scan

( 127.0.01 [l Enable Card Download

Display FEP Inside for Multiple Loyalty

Display FEP Outside for Multiple Loyalty

Receipt Offiine Message

-

(

e

Remove Program

Description
Enables the loyalty program.

Select the loyalty provider from the list that is used to host the name. The list is a predefined selection
of approved loyalty hosts.

Sets the Merchant ID provided by the network.

-
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Program Name
IP/Host
Port

Heartbeat (Seconds)
Enable TLS

Enable Barcode Scan

Enable Card Download

Display FEP Inside for
Multiple Loyalty

Display FEP Outside for
Multiple Loyalty

Receipt Offline
Message

Remove Program

Cards

( Parameters )
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Sets the Program ID for the loyalty program.
Sets the IP address of the loyalty host. (Provided by loyalty host)
Communication Port Number for the primary loyalty host. (Provided by loyalty host)

Sets the interval in seconds between network status checks from the Electronic Payment Server to
the Loyalty Host. Minimum amount allowed is 120 seconds.

Enables the use of a secure Transport Layer Security (TLS) connection to the loyalty host. When TLS
is used, data is encrypted over the communication line.

Enables a Barcode Scanning for the related FEP. The flag default is disabled.

Enables the Loyalty Card Table Download that allows the Loyalty Host to send down card table
entries. The flag default is disabled.

Displays Loyalty Program at the POS when multiple loyalty is used.

Displays Loyalty Program at the DCR when multiple loyalty is used.

When loyalty is offline, the message entered here will print on the receipt.

Removes the loyalty program.

Field

Card Name
Abbreviation

Lower ISO

Upper ISO

Description
Name given to identify this entry.
Sets a two digit abbreviation for the card.

Sets the lower value of the card (BIN) range. The entered card number must be greater than or
equal to this number to match the table entry.

Sets the upper value of the card (BIN) range. The entered card number must be less than or equal
to this number to match the table entry.

-
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PAN Length Sets the number of digits to be used with the card.
Hybrid Sets the card as a hybrid card.

General Settings

1. To view or edit individual site loyalty configurations navigate to C-Site Management > Configuration >
Site Management

2. Use the search by Site name or Hierarchy drop-down menu to locate the site you wish to modify the
loyalty configurations for. After the site name is located, click on the name to open the site
configuration.

Sites

54 Sites Haraschy ) e —_—

3. Select Payment Operations > Loyalty from the left column to view the site’s loyalty parameters.

4. To view the site’s general loyalty settings, use the drop-down menu on the top left column to switch
from the loyalty programs to General Settings.

General Loyalty Settings

Enabés ARermle D . Joumal Losmity 1D to POS . Lises Loy Test For Indicsy Prosrges
[l Promt for Loyaity after payrrent B Send rewensd prompt o Cashier [l Pramt for roweard anly an fusd

. Denpslay Host Mmsagos

Arsenrdd Promgl Timeout (in seconch)

(30

Field Description
Enable Alternate ID Enables the payment device to prompt for an alternative ID for loyalty.

Prompt for Loyalty after Prompts the customer for loyalty after they have paid for the transaction.
payment

Display Host Messages Loyalty messages will appear on the POS from the loyalty host.

-
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Journal Loyalty ID to
POS

Send Reward prompt
to Cashier

Reward Prompt
Timeout (in seconds)

Use Long Test for
Indoor Prompts

Prompt for reward on
fuel only
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Captures the customer’s loyalty ID in the site’s POS journal logs.

Enables the cashier to answer the PIN pad prompt from the POS in the event the customer hands the
cashier cash and leaves the store without using the PIN pad display.

Sets a time out value for the loyalty reward prompt in seconds.

Shows longer prompts inside for loyalty rather than abbreviating them.

Enabling this setting will only prompt the customer for loyalty if they are purchasing fuel.

5. Loyalty Programs (PCATs Loyalty in Verifone Commander’s Configuration Client) assigned to the site
will be found under the Programs drop-down menu.

If the loyalty program is managed through Enterprise configuration, then it will have a label next to the
program name indicating ‘Enterprise’.

@ Modanna Rd Details

\' Store Operations

v)

\
J
Payment Partner ~ ™
| 1: akeela

Loyalty
Mobile

\'I. Access Control

Program1 (&

Parameters N1 '

General Communication Parameters Settings

(:) FEP Enabled |P/Host |l Erable Barcode Scan

Provider |:' 1921683111 ) [l Enable Card Download

Dis| FEP Inside for Multiple Loyal
Heartbeat (seconds) W Dsspiay = e

Merchant ID (!300 \ [l Display FEP Outside for Multiple Loyalty

|:’1 2343 ) Receipt Offfine Message
- . Enable TLS I(IF'IEBSE scan the card

Program Name .

I:_’Frogram 1

-
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Mobile
Individual site configurations for mobile payments is found under C-Site Management > Configuration >
Site Management > Site Name > Payment Operations > Mobile.
Edit Site Details

1. To edit site mobile configurations, navigate to C-Site Management > Configuration > Site
Management > Select the Site Name from the list.

2. Select Payment Operations > Mobile.

3. The Site Settings are presented by default. Complete the following parameters shown specific to the
Mobile Payment Host being configured. See table below for details on each field.

Modanna Rd Details =

Copy Mobils Configurstion | | SleSetings  + |

Erabis Mobis Payrants

Gt Mame
| Wiy MAcie Progmm

! moress Contro

[ WAciela Tarmarad Fstoh Detad Repor

Femnai

| Sianderd Format

Field Description

Enable Mobile Enable to accept Mobile Payments.

Payments

Welcome Message The site’s welcome message (100 characters).

Data Storage Time The Data Storage Time for retention (0-30 days).

Report The Mobile Terminal Batch Detail Report is the only report for the format type below.

-
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Format The combination of these fields are used to set the format type for each report from the report
drop-down menu.

The values are “Standard” and “Extended Authorization.”
The default format type would be “Standard” for all reports.

In the Chevron distribution, the Mobile Terminal Batch Detail Report will default to Extended
Authorization format.

Standard: In this format max limit for authorization number is 14 digits and first 14 digits gets printed.
Extended Authorization Format: Min limit for authorization number is 1; no upper limit.
As of now, this feature is applicable only for Mobile Terminal Batch Detail Report.

Edit Program Details

1. To edit site mobile configurations, navigate to C-Site Management > Configuration > Site
Management > Select the Site Name from the list.

2. Select Payment Operations > Mobile.

3. The Site Settings are presented by default. To modify the programs, switch the drop-down menu to
Program List.

Mcdanna Rd Details ®

Progrirea st o

et Pro Fam W

Bentierrnd Erplinpes & Tt aremrsl. [wicalinile Puprs

4. Use the Select Program drop-down menu under Program List to modify any site specific MIDs. They
must have the checkbox enabled to add any site specific details.

-
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Balnon PrOQIeT W

W Voo TEST
Wil o 1
W Femane

W Oty 0

W e

I 0 o2 Programi
B s
e

| Rt

| S

. WAL PR iarh

| e

B. Use the (+) next to the MID to add additional details such as Store ID, Settlement Employee Number,
Settlement Passcode, and Phone Number. See table below for details on each field.

verifone

Add More Details for Mobile Host 1

Store ID

£l

Fd

Site Terminal ID

321

Settlement Employee Number

Settlement Passcode

Phone Mumber
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Store ID
Site Terminal ID

Settlement Employee
Number

Settlement Passcode

Phone Number
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Description
The Store Identification (ID) Number.
It is the ID number for the terminal received from the mobile payment host.

It is the number used by the Verifone Commander for settlement with Mobile Payment Host. The
Settlement Employee Number is provided by the Mobile Payment Host.

It is the Passcode used during settlement assigned by Mobile Payment Host.

Store Phone Number.

Copy Mobile Configuration

1. To edit site mobile configurations, navigate to C-Site Management > Configuration > Site
Management > Select the Site Name from the list.

2. Select Payment Operations > Mobile.

3. Click Copy Mobile Configuration from the top right corner of the screen.

E— || Copy Mobile Configuration |

Enable Mobile Payments

4. Alist of sites will appear to select a location to copy the configuration from. Use the Hierarchy drop-
down menu or the search by name function to narrow down the site. Select the site you want to
copy the Mobile Program from.

Select site to copy from:

|' Hierarchy ||

() Mission St (e ‘D) Rockefeller Bivd
,

-
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5. The copy form will open after the site is selected. The MIDs are copied from the store selected on the
previous screen, along with their configurations. Make sure you click the Select Program button to edit

and update the MIDs for the location.

Copy from ' Mission St ' to ' Modanna Rd
[l Enabie Mobile Payments

Site Name

I::'-test

Welcome Message

C

Data storage time

(30 ) Days
Report

I:' Mobile Terminal Batch Detail Report

| Select Program |

 MOBILE TEST
W Retsiler
Quality Ol
Animals

B ©G Test Program!
Octan

' Program 2
B =3

’ Program A
B vz

' Gulf

' MPPA2

Format

( standard Format

6. Selecting the + next to the MID will allow entry of additional configuration parameters: Store ID,
Settlement Employee Number, Settlement Passcode, and Phone number. See table below for details
on each field.

-
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Add More Details for Mobile Host 1

Store ID

| 123 /

Site Terminal ID

| 321 ]

Settlement Employee Number

Settlement Passcode

Phone Number

Field Description
Store ID The Store Identification (ID) Number.
Site Terminal ID It is the ID number for the terminal received from the mobile payment host.

Settlement Employee It is the number used by the Verifone Commander for settlement with Mobile Payment Host. The
Number Settlement Employee Number is provided by the Mobile Payment Host.

Settlement Passcode It is the Passcode used during settlement assigned by Mobile Payment Host.

Phone Number Store Phone Number

7. After all changes are made, select Apply changes.

Disable Mobile Payments for an Individual Site

1. To edit site mobile configurations, navigate to C-Site Management > Configuration > Site
Management > Select the Site Name from the list.

2. Select Payment Operations > Mobile.

3. Deselect the Enable Mobile Payments check box.

-
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Site Name

4
| My Mobile Frogram

o

Welcome Message
i 3
l\ Go Mobile

o

Data storage time

£
I\_.‘::D _,.-*‘I Days

Report

-~

I: Mobile Terminal Batch Detail Report

e

Format

|:' Standard Format

.

4. Click Apply changes in the bottom right corner.

Mobile Payment Configuration Troubleshooting

Verifone C-Site Management User Guide

| Copy Mobile Configuration .

Apply changes I::. Discard -:]

* Mobile Site Configuration Not Found — If the site is Active, confirm they are on Release 53.41
software or higher. Site Assets can be checked under Reports > Site Assets. Search for the Service
ID of the location and then confirm the Verifone Commander’s Software Release is showing 53.41 or

higher.

* Mobile Payment Program Adapter is Blank — The Mobile Payment Program Adapter selection only
supports VFI Mobile 1 and VFI Mobile 2. If the program was imported from a site that had FDC
Mobile or Local MPPA was selected, then the field will be blank in the Mobile Payment Program after

it is imported.

verifone
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Primary Payment

Card Price Tiers

Card Price Tiers B

DB - AEMP DEBIT
DB - DEBIT

DB - GASCRD DEBIT
DB - GASPRO DEBIT
DB - MC DEBIT

DB - VISA DEBIT

DS - DISCOVER

DS - DS OPERATION

' DS - UPAY

Field

Search Cards

Select Card

Card Name

Price Tier

Select Card

Description

Use search box to find a card.

Use the scroll bar to select a card to assign a Price Tier.
Displays the selected card.

Assigns “Cash” or “Credit” to the card selected.

-
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Cashback & Fees

':_ Card Price Tiers l Cashback & Fees

Cashback EBT Cashback Convenience Fee

Field Description

Cashback Enabled Enables cashback on cards.

Force PIN Entry Enforces the customer to enter a PIN.

EMV Cashback Displays “Wait for Cashier” prompt during EMV Cashback transactions.
Prompt — Wait for

Cashier?

Cashback Fee Sets the fee associated with cashback on MOP transactions.

EBT Cashback Enables cashback on EBT transactions.

Enabled

Enable Convenience Enables the fee for convenience.

Fee
Fee Amount Sets the convenience fee amount.
@
. [ ]
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Access Control

POS Security

The POS Security section is located under C-Site Management > Site Management > (Select Site) >
Access Control. POS Security is used for creating POS users, such as cashiers, and controlling their access
levels to functions within the POS. Changes made at the site will sync with the dashboard, and changes
made within Verifone C-Site will sync with the store after saved.

Employees

The Employees tab is used to add new employees who can access the point of sale. The ID number
assigned to the employee will be entered into the POS at the time of login along with the password.

@ Station 8 Details ®

(‘S(o[eOpegaﬂons vJ [SOCISCC W | Security Controls | [ Sales Functions |

— s ~
Access Control ”~ @ | Delete )
A h . 4
POS Security \ /
Select Employees

A Name Security Level
| Forecourt ) Nare 8 4
) g 2 - STORE MANAGER ( CORPORATE ) (9 «~)
~ M 7
3 - ASST MGR
4 - CASHIER New Password Confirm New Password

5-KDS (: ) (\

Employee Number
(’1 \) Can Cashier

Field Description

Search Employees Allows for employees to be searched by their name or exact ID number entered.

Select Employees Displays a list of existing employees.

ID The number entered in when a cashier or store personnel log into the register. The ID assigned must

be a unique number from 1-2000.

Name Used to identify the POS user/employee.

-
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Security Level A value between O and 9 that defines what areas the employee has access to on the point of sale.
The level of 9 provides the most access to areas within the POS. Specific details on what security
levels are required for functions on the POS can be found within the Security Controls tab and the
Sales Functions tab.

New Password / The password used when the employee logs into the POS. The value can letters and numbers.
Confirm password

Employee Number The employee number is a required field. This number is used for payroll reports.
Can Cashier Enabling the Can Cashier check box allows the employee to log into sales mode (CSR Functions) on

the register. If this option is disabled, they will not be able to log into the register and ring in sales.

Security Controls

(@) 113.0 Dotails

Store Operabons

Salect M d

Car YWeash

Field Description
Select Menu ID Allows the category
Select SubMenu ID Allows further filtering of specific security controls within a selected security control menu ID. This

field will vary depending upon the Select Menu ID options.

Description & Security Shows the description of the security function along with the minimum required security level to utilize
Level Table that function.

Apply All / Security The security level drop-down menu and Apply All button allows the security level for all the displayed

Level Function security controls to be changed in bulk to the selected Security level. Select the Security level from
the drop-down menu and select Apply All to see the change. Select Apply Changes on the form to
save the changes. Use Discard to clear any changes made.

-
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Sales Functions

Functions that are tied to sales are separated into the Sales Functions tab. Options such as Error Correct,
No Sale, Suspend, and Price Override can be found here. If the security level is O, then all users with the
cashier checkbox enabled can perform the function.

The security level drop-down menu allows a security level to be set for all sales functions shown. An
additional search box allows the functions to be filtered down searching for the first letter of the
description. For example, typing A will display apply updates.

Employees ' ' Security Controls '

Security Level

( Description Security Level

Delete Order (DFO)
Discount (MDC)

Error Correct (ECR)
Apply Updates (MUP)
No Sale (NSA)

Pay Out (POU)

Price Override (POR)
Refund (REF)

Safe Drop Correction (SDC)

-
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Forecourt

DCR Configuration

Receipt Settings

Receipt Sattings Site Sottings DCR Settings

Receipts sattings

Ay Print Racaipt | | Lesiet Papsd Al @

: Recel Prompt Bators Sato | Prarmpt Prapay Recaiat Outsic @

[ ] receist Prompt After Sale

R ipt Header

(" weLCOME WELCOME

Racaipt Trailer

|:: THAMK YOU ) ' THANK YO

) A 1 =1 - an
| HAVE A NICE DAY HAVE A MICE DAY

®
® -
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Field Description
Always Print Receipt Receipt prints always after fueling. If disabled, the customer will be prompted to print the receipt.

Receipt Prompt Before Customer will be prompted for a receipt before fueling.
Sale

Receipt Prompt After = Customer will be prompted for a receipt after fueling.
Sale

Low Paper Alarm Alerts the cashier when the DCR is low on receipt paper.

Prompt Prepay Receipt Customer will be prompted for a receipt at the DCR after prepaying inside.
Outside

Discard Discard changes made to this section. Displays when a change is made on the screen.

Apply Changes Apply changes made to this section. Displays when a change is made on the screen.

Receipt Header

Receipt Header

1. Key in up to 20-characters for each of the five available text lines for the Receipt Header. It will be
displayed on the form on the right side of the page.

2. Forthe Receipt Header alignment, select Left, Center, Right.
3. Click the circled ‘X’ to delete the available text line.

4. Click ‘Add’ to enable the displayed text.

-
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Receipt Trailer

Receipt Trailer

(| THANK YOU

i

| HAVE A NICE DAY

1. Key in up to 20-characters for each of the five available text lines for the Receipt Trailer. It will be
displayed on the form on the right side of the page.

2. For the Receipt Trailer alignment, select Left, Center, Right.
3. Click the circled ‘X’ to delete the available text line.

4. Click ‘Add’ to enable the displayed text.

-
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Prompt Settings

Prompt Settings
Handle Up Alert Message (in Seconds) @ Error Prompt Time (In Seconds) @

(35 J (s

Info Prompt Time (in Seconds) @ User Prompt Time (in Seconds) @

|'/-
(18
S

Enable Keypress Besp @
Enable Attention Beep €@
Enable Mistake Beep @

[ ] Pay Inside Cash/Credit Prompts

[ ] Audible Help Message On POS

Apply Changes

Field Description

Handle Up Alert Amount of seconds the Handle Up Alert displays on the POS for the cashier when the dispenser
Message (In handle is removed with no activity.

Seconds)

Error Prompt Time Amount of seconds an error prompt on the DCR.

(In Seconds)

Info Prompt Time Amount of seconds the last message displays on the DCR.
(In Seconds)

User Prompt Time Amount of seconds user input is required for DCR prompts.
(In Seconds)

Enable Keypress Enables a beep on the DCR for keypresses. This only applied to Wayne and Tokheim DCRs.
Beep

-
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Enable Attention Enables a beep to get the attention of the customer. This only applies to Wayne, Gilbarco, and
Beep Schlumberger DCRs.

Enable Mistake Beep = Enables a beep when the customer presses an incorrect button selection. This only applies to
Wayne, Gilbarco, and Schlumberger DCRs.

Pay Inside Cash/ Enables Pay Inside Cash/Credit Prompts to be displayed on the DCR.
Credit Prompts

Audible Help Enables an audible help message on the POS when pressed at the DCR.
Message On POS

Discard Discard changes made to this section. Displays when a change is made on the screen.

Apply Changes Apply changes made to this section. Displays when a change is made on the screen.

-
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Other Settings

-
r,

| Store Operations

I:" Payment Operations

.

| Access Control

\
LY

Forecourt ~

DCR Configuration
Fuel
Fuel Tax Exemptions

Field Description
Approve All Sales
Allow Fill-Up with

Verifone C-Site Management User Guide

( DCRSettings |

Site Settings

Other Settings

( Receipt Settings |

| Prompt Settings

Other Settings

|:| Approve All Sales @
Allow Fill-Up with Preset

[ ] Armed Forces Restriction @

I::' Discard ':I Apply Changes

If enabled, cashier can approve all outside sales.

Enable to allow the transaction to show the preset amount for fueling before the customer begins

Preset dispensing fuel. The amount can be changed by the customer.

Armed Forces
Restriction

Discard

Apply Changes

verifone

If enabled, DCR displays the Armed Forces prompt “Are you authorized [Y/N]?” prior to dispensing.

Discard changes made to this section. Displays when a change is made on the screen.

Apply changes made to this section. Displays when a change is made on the screen.
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DCR Settings

| Site Settings DCR Settings
Idle Screen Keys Configuration

DCR Promo Message @

( Receipt Settings

| Position Settings

THANK YOU FOR SHOPPING WITH US TODAY.

Select Attended Screen

Assigned Position: 2-57-9,13-16
Default

.. Graphic Enabled
Text Line 1

| Press Payment Key
R

Field Description

DCR Promo Message
Add
Delete

Attended Idle Screens

Unattended Idle

screens.

Screens screens.

verifone

Click ‘Add’ to enable the DCR Promo Message.

Click ‘Delete’ to remove the DCR Promo Message.

Verifone C-Site Management User Guide

-

Apply Changes

Key in the text for the customer to view while they are fueling.

Use the drop-down menu to select “Attended Idle Screens” for adding new or selecting saved

Use the drop-down menu to select “Unattended Idle Screens” for adding new or selecting saved
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Search By Name

Select Attended
Screen

Name

Copy Screen
Assigned Position
Graphic Enabled
Text Lines 1-4
Discard

Apply Changes

Verifone C-Site Management User Guide

Use the search box to find saved idle screens.

Click on the desired DCR idle screen name in the list.

Key in the text for the new DCR idle screen or edit an existing one.

Use the “Copy Screen” button to make a copy of the selected or newly created DCR idle screen.
DCRs that are assigned the selected idle screen.

Enable if the DCR has a graphic interface.

Key in the text to be displayed on the DCR idle screen.

Discard changes made to this section. Displays when a change is made on the screen.

Apply changes made to this section. Displays when a change is made on the screen.

-
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Key Configuration

[ ReceiptSettings | | SiteSettings | (NSl Alser
) Keys Configuration | Position Settings

Q)

Select Key Name

. Enable Alphanumeric

-

) Apply Changes

Field Description

Search Key Name Search by keying in the name of the DCR keypad layout.

Select Key Name Select the DCR keypad to make changes.

Name This is the name of the DCR keypad layout.

# of rows Select the desired number of supported rows for the DCR keypad layout.

# of columns Select the desired number of supported columns for the DCR keypad layout.

Enable Alphanumeric  Select to enable a DCR to allow alphanumeric keys.

-
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Discard Discard changes made to this section. Displays when a change is made on the screen.

Apply Changes Apply changes made to this section. Displays when a change is made on the screen.

Assigning an MOP to a DCR Key

1. Click on the desired key and three drop-down menus display on the left side of the keys.

| Unused

Unused Key Code

3. Select “Payment.”

[ combination
Function

| Numeric

Payment

-
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4. Click on the Key Code drop-down menu.

Unused Key Code

IDLE Function

F—

| Pay Inside Credit
Pay Cashier Credit
Credit Inside
Pay Qutside Credit
Pay Credit Outside

| Credit Inside

-
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Assigning a Combination to a DCR Key

1. Click on the desired key and three drop-down menus display on the left side of the keys.

2. Click on the Key Type drop-down menu.

Unused Key Code
| Unused
IDLE Function

| Unused

3. Select “Combination.”

Combinat'lcn
Function
™ Numeric
Payment

Unused

Combination

-
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4. Click on the Key Code drop-down menu.

IDLE Function

IS
I,\_ Discard _,'I Apply

5. Select the desired Combination Key Code from the Combination Key Code drop-down menu.

'Clear / Cancel
Cancel / Clear
Clear / No
No / Cancel

Yes / Enter

6. Click on the Idle Function drop-down menu.

Unused Key Code

Unused

IDLE Function

IS
I,\_ Discard _,'I Apply

-
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7. Select the desired Loyalty function or leave as Unused.

Key Type

. Loyalty Card Swipe

Loyalty Manual Entry

Assigning a Function to a DCR Key

1. Click on the desired key and three drop-down menus display on the left side of the keys.

-
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2. Click on the Key Type drop-down menu.

IDLE Function

IS
I,\_ Discard _,'I Apply

3. Select “Function.”

'F-Com bination
Function
| Numeric
Payment

Unused

4. Click on the Key Code drop-down menu.

IDLE Function

T
I,\_ Discard _,'I Apply

-
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Cancel

| Canc/Annul

Clear

Cormr

Enter

OK

Click on the Idle Function drop-down menu.

Unused Key Code
| Unused

IDLE Function

| Unused

Verifone C-Site Management User Guide

5. Select the desired Function Key Code from the Function Key Code drop-down menu.
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7. Select the desired Loyalty function or leave as Unused.

Key Type

. Loyalty Card Swipe

Loyalty Manual Entry

Assigning a Numeric to a DCR Key

1. Click on the desired key and three drop-down menus display on the left side of the keys.

2. Click on the Key Type drop-down menu.

-
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IDLE Function

3. Select “Numeric.”

"I...:Iam bination
Function
R Numeric
Payment

Unused

4. Click on the Key Code drop-down menu.

Unused

IDLE Function

IS
I,\_ Discard _,'I Apply

-
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5. Select the desired Numeric Key Code from the Numeric Key Code drop-down menu.

6. Click on the Idle Function drop-down menu.

Unused Key Code

‘ Unused

IDLE Function

IS
I,\_ Discard _,'I Apply

-
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7. Select the desired Loyalty function or leave as Unused.

Loyalty Card Swipe

Loyalty Manual Entry

Rewards

Rewards

-
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DCR Settings > Position Settings

( b €
Receipt Settings) L S'rleSettings)

- p
\ Idle Screen \) I(\ Keys Conﬁguration\)
v

Select DCR Position

Screen Settings

B Enable Graphic Support [ ] Graphic Keypad

Unattended Idle Screen DCR Key

|/ Defauit 123 |/ Test
A 4 N

Graphic Screen Size Graphic Text Lines

[ 5INCHES ) [ 2Lines
N 7

Payment Settings

[ ] Enable EMV [ ] Pay At Pump @

IP Address Port

C &

Advanced Settings

[ ] Push To Start Button [] Lever on Pump
[ ] Enable Scanner

Primary Graphic Side @

(o

Discard
M &y

-
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Select DCR Position

Field

Select DCR Position
Copy To

Add

Delete
Screen Settings

Field

Enable Graphic
Support

Graphic Keypad
Graphic Printer
Attended Idle Screen
Unattended Idle Screen
DCR Key

Graphic Display
Graphic Screen Size

Graphic Text Lines

Payment Settings

Field
Enable EMV
Pay At Pump
Enable Debit
IP Address
Port

Contactless Mode

Description

Select a DCR position to apply the position settings.

Select one or multiple DCR Positions to apply the same settings to each one.
Click on Add to apply the settings to the DCR position(s).

Click on Delete to remove the settings from the DCR position(s).

Description

Enable if the DCR supports graphics.

Enable if the DCR has a graphic keypad.

Enable if the DCR has a graphic printer.

Select the Idle Screen that the customer or attendant will see when used in Attended Mode.
Select the Idle Screen that the customer will see when used in Attended Mode.

Select the DCR Key layout.

Select ‘Monochrome’, ‘Color’, ‘ROM’, or ‘Monochrome + ROM’ for the Graphic Display.
Select the supported size between 5” to 12” for the Graphic Screen Size.

Select between 1’ to ‘4’ lines or ‘full screen’ for the Graphic Text Lines.

Description

Select to allow EMV at the DCR.

Select if the pump has a DCR and is available for use.
Select to allow Debit at the DCR.

Enter the IP Address for DCR Communication.

Enter the Port number.

Select to enable ‘Contactless MSD’, ‘Contactless EMV’ or ‘Contactless Disabled’ Mode.

-
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Advanced Settings

Field Description
Push To Start Button Ensures that the correct instructions display on the DCR.

Grade Select Button Customer must press a corresponding fuel button when a pump dispenses multiple fuel products
from a single hose.

Lever On Pump Select to enable the DCR prompts to display instructions for starting to fuel from dispensers with or
without a lever.

Enable Scanner Select if the DCR has a scanner and is available for use.

Menu Capable Select if the DCR position has graphics.

Primary Graphic Side  Gilbarco Only. Enter the position number of the DCR that operates the graphic for both sides of a
pump.

Discard Discard changes made to this section. Displays when a change is made on the screen.

Apply Changes Apply changes made to this section. Displays when a change is made on the screen.

-
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Fuel

Fuel Prices

Location fuel prices can be modified by selecting the Pending Prices option on the right side of the screen.
Prices that are currently active at the store will be found by selecting ‘In Effect Prices’.

Fuel prices are set based on the products and service levels assigned at the location. If there is uncertainty
which products are assigned at the dispensers, refer to the Fuel Configuration — In Effect tab > Fuel
Positions.

I Fuel Configuration I

Product Minimum Street Price

( uNLD1 (1 ) ( |Pending Prices )

Tier One Prices Tier Two Prices

Apply to all the Tier One Prices ( e Apply to all the Tier Two Prices

Service level MOP L Service level MOP

After the product is selected, the price can be changed for all the service level and MOP options by entering
in an amount in the ‘Apply to all the Tier One (Two) Prices’ field and selecting Apply. Prices can also be
entered in for each Service Level and MOP.

The Minimum Street Price is currently a read only field and sets the minimum amount that fuel prices can be
set to. This field is intended to prevent incorrect fuel prices from being assigned.

Select Apply Changes on the bottom of the page to save the updates. Select Discard to undo any changes
made.

-
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The Fuel Configuration area is read only shows the Fuel Configuration that is ‘In effect’ at the site. Fuel
configuration is set up at the time of installation by a Verifone Authorized Service Contractor (VASC).

CAUTION

=1
—

to making changes.

Fuel Configuration

Unit of Measure

Total Decimal Position

Multi-Grade Timeout{Min)

Ignore MOP Conflict

Force 8 Cents Per Gallon
Approve All Enabled

Recall Autocollect Inside
Gilbarco Six Digits Money Display
Require Attendant Card

Collect Additional Data

Offline Fuel Prompt Real Time Sales Data

Number of Seconds Notif. Freq. (Milliseconds)

verifone

Fuel Positions |

Tier2 Schedule Settings
Start Tier 2 Pricing

Postpay Schedule Sattings

Start Postpay Allowed

Manual Approval Schedule Settings

Start Manual Approval Required

Grade Restriction
Enforce Prompting Inside

Commer -onfiguration

Alert Cashier (Minutes)

Proprietary + Confidential. © Verifone Inc. All rights reserved.

Modifications to the store's fuel configuration can negatively impact site functionality.
Consult the Verifone Helpdesk or a Verifone Authorized Service Contractor (VASC) prior

Number of Tier Hours

Number of Postpay Hours

Number Manual Approval Hours

Prompt Restriction Outside
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Fuel Tax Exemptions

The Fuel Tax Exemption section is located under C-Site Management > Site Management > (Select Site) >
Forecourt. Fuel Tax Exemptions are used to configure tax exemptions on fuel sales that can be applied to
post pay fuel sales. The Fuel Tax Exemption configuration form allows up to five fuel tax exemptions to be
entered. The exemption can be based on an amount per gallon, tax rate configuration, or both.

[ Store Operations

Fuel Tax Exemptions

Field

Fuel Tax Exempt
Record ID

Name

Amount

Type

Print Receipt Line
(Signature Line)

Fuel Tax Receipt Line

Select Fuel Tax Exemptions \ [ Delete )

2-UNUSED
3- UNUSED
{ UNUSED
4 - akeela L —
5-UNUSED
Type
[ Both
. Print Receipt Lines

3

Description

A record number must be entered from 1-5 for the fuel tax exemption.

Enter a description for the fuel tax exemption.

Enter the amount for fuel tax exemption if amount per gallon or both are selected for the Type drop-
down menu.

Select between Amount Per Gallon, Tax File Entry, or both to determine how the tax exemption is
applied. If Tax File Entry or Both are selected, a tax will need to be selected from the tax drop-down
menu.

Determines whether the fuel tax receipt lines configured will print with the sale or not.

Allows the receipt printed for transactions with fuel tax exemption to include specialized receipt
information.

-
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VIPER TABLE MANAGEMENT

Viper Table Set Management is intended to perform scheduled updates to the card tables in the Verifone

Commander. Table updates are XML formatted and must be specifically formatted to ensure no errors
occur.

Updates should not be performed without assistance from Verifone at this time.

CAUTION
L !"' Updates should not be performed without assistance from Verifone at this time.
®
. [ ]
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CONNECT DEVICE TO CLOUD

The Connect Device to Cloud section will provide details on how to enable the Cloud Connect feature in
Verifone Configuration Client. Each Verifone Commander must be onboarded to the cloud within Verifone
Configuration Client and added to Verifone C-Site Management.

If the site's information was not added to Verifone C-Site Management prior to completing
NOTE the Verifone Configuration Client onboarding steps, the site will automatically be added to
[j@ Sites within Verifone C-Site Management.

The site name will be the site's service ID and the hierarchy will need to be modified.

Requirements

» The site where the device is located is set up within Verifone C-Site Management within
Administration > Sites.

*  The Verifone Commander onboarder must have credentials for Verifone C-Site Management.

* DNS must be enabled within Verifone Configuration Client (Local Area Network Configuration) for
the connection to be successful.

-
Ve rlfone Proprietary + Confidential. © Verifone Inc. All rights reserved. 177



Verifone C-Site Management User Guide

Pre-Release 54.02 - Connecting Device to Verifone C-Site Management

Ensure that the instructions are followed for the correct
software release installed on the Verifone Commander priorto |,
beginning onboarding. To begin the process of attaching the
Verifone Commander to the cloud: Date & Time

1. Log in as Manager in Verifone Configuration Client and Registration

. ops View Feature Info
navigate to Initial Setup > Cloud Connect. _ _
IMaintenance Configuration

System Properties

Local Area Network Configuration
VHQ Configuration

Commander Console

Cloud Configuration Manager

Cloud Connect <

Initial Setup  Store Operations  Prom

2. Select the Cloud Connect button from the screen.

Security  Initial Setup  Store Operations  Promos and D

Cloud Connect

ti Click the button below to start registration

Cloud Connect

-
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3. A URL and a user code is generated. Copy the User Code that was generated on your Configuration
Client and then select the URL on your screen.

Cloud Connect

&¥ You have 14 minutes to submit this user code before it expires

gt Lol -vam vims comdoauth2/malmaNVerfoneP el ofdavice/user

Confim Verficaton -ff——

4. After the URL opens, enter the user code from Configuration Client into the ‘Enter your code here’ field
and click Submit.

Enter the code:

Enter vour code here I I

isuamrr

LEAVING SITE

© Leaving this site will log you out. Continue and log into the new site?

Yes, log into the new site| No, go back

-
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5. Click Yes, log into the new site. A page will open that will prompt you to log into C-Site Management.

6. Login with the credentials for Verifone C-Site Management.

Sign in to Verifone Central

Email

Password

protected by reCAPTCHA [P o |
Privacy - Terms

Forgot password?

7. The next prompt will prompt you to allow sharing the information from the Verifone Commander. Select
Allow. A message will display ‘DONEY’.

PETROCLIENT
This applicatsan is reguesting the following privace informathon
wirite

Vi i SRt in a5 undelingd mr, polelverilane com

Den

8. Return to the Configuration Client page. Select Confirm Verification from the Cloud Connect window.

Cloud Connect

&F You have 14 minutes to submit this user code before it expires

URL: (Randomly Generated URL is specific to your account.)
User Code: 8675309

Confirm Verification ‘4—

-
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9. The Cloud Connect window will display ‘Registration completed on (Date / Time)'.

Security  Initial Setup  Store Operations Promes and Dis

Cloud Connect

¥ Registration completed on 06/20/2022 15:26:07

[jﬁ NOTE There is a 5-minute delay from when the site will show Active within Verifone C-Site
Management after it is registered.

WARNING If DNS is not enabled in Configuration Client > Initial Setup > Local Area Network
Connection, then the Verifone Commander will not be able to resolve the IP from
the URL and onboarding will fail.

-
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Troubleshooting

Error response ‘User Code has Expired. Please star the registration again.’

Configuration Manager
@ User Code has expired. Please start the registration again

* Make sure the user trying to onboard the Verifone Commander has the ‘Commander Onboarder
Role’ assigned within Verifone C-Site. If the role has been assigned to the user, then contact the
Verifone Helpdesk. The expiration time for the user code is 14 minutes, but the role assignment issue
will appear immediately.

Error response ‘Communication error, please check network settings.’

Configuration Manager

'f@ Communication emor, please check network settings

Ok

1. For the following payment networks, no routes need to be added into Initial setup > LAN Configuration
as the MNSP will make the changes needed: BP, Sunoco, and Chevron*. Chevron is making the changes
to the MNSP with the assumption that the Payment NIC is configured for the default route. If the
Payment NIC is not the default route, then it needs to be changed to the default route, saved, and the
Verifone Commander must be rebooted. See the Chevron Playbook for more details.

2. For Shell, Generic Buypass, etc. where the Payment NIC is NOT the default route, then DNS routes are
required. DNS 1 8.8.8.8 and DNS 2 8.8.4.4 — Unless other DNS routes are required by the site’s network
administrator.

3. Site such as Exxon, Generic Buypass (Gulf, Sinclair, etc.) and others who do not have their own IP
scheme and has the Payment NIC set as the default route would need to add the following Host Routes
and DNS settings into Initial Setup > LAN Configuration:

-
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Host Routes

Host Route
Description

C-Site VAM 1
C-Site VAM 2
C-Site VIC 1
C-Site GSC 1
C-Site GSC 2
C-Site GSC 3
C-Site MQTT 1
C-Site MQTT 2
C-Site MQTT3
DNS 1

DNS 2

DNS Settings

IP Address

23.23.135174
18.213.229.217
34.117.16.222
184.72129.214
54.221.203.197
52.72155.235
184.73.231.196
3.212.149.223
52.6.28.56
8.8.8.8

8.8.4.4

+ DNS1:88.8.8
« DNS2:8844

verifone

Gateway

192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31
192.168.31.31

Proprietary + Confidential. © Verifone Inc. All rights reserved.

Subnet

255.255.255.255
2565.255.255.255
255.255.255.255
255.255.255.255
2565.255.255.255
255.255.255.255
2565.255.255.255
2565.255.255.255
255.255.255.255
2565.255.255.255
2565.255.255.255

Verifone C-Site Management User Guide
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Release 54.02+ - Connecting Device to Verifone C-Site Management

In Verifone Commander software release 54.02 and higher, there have been enhancements made to
onboard the Verifone Commander. The steps have been simplified from previous releases.

Ensure that the instructions are followed for the correct

software release installed on the Verifone Commander

prior to beginning onboarding.

1. Log into Configuration Client and navigate to Initial
Setup > Connect to Verifone C-Site Management.

Security

Initial ;ﬁup Store Operations  Promos and Disq

Date & Time

Registration

View Feature Info
Maintenance Configuration

Local Area Network Configuration

WHQ Configuration

Commander Console

Cloud Configuration Manager
Connect to Verifone C-Site Management

2. Enter in the C-Site Email and Password to connect the Verifone Commander to C-Site. Do not use the
Configuration Client Credentials — they will not work. If the site doesn’t have an account, selecting the
‘Don’t have an account?’ option will provide information for the site to sign up for Verifone C-Site

Management.

Connect to Verifone C-Site Management

€ Don't have an account? *

C-Site Email |
C-Site Password |

Submit

Create C-Site account

If your company does not have a C-Site account already,

you can register by going to https /petromop verifone doud/ N
|

Or you can scan the QR code below

3. When the correct crednetials are entered in, Configuration Client will display ‘Connecting to Verifone C-

Site Management in Progress’.

sl

Connecting to Verifone C-site Management in progress

L

-
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4. After the onboarding is complete, then below message will be displayed.

Connect to Verifone C-Site Management

Onboarding completed on 09/19/2023 12:23:00

Troubleshooting

Error message ‘Invalid credentials, please try again. Please make sure you are using your C-Site credentials
to login’:

Configuration Manager

':@ Invalid credentials, please try again. Please make sure you are using your C-Site credentials to login.

s

il
» Confirm the Verifone C-Site Credentials are being used and not the Verifone Configuration Client

Credentials.

Error message ‘Wrong Serial Number — Service ID Mapping. Please contact helpdesk’:

Configuration Manager

=
@j’ Wrong Serial Number - Service ID Mapping, please contact helpdesk

* The service ID may be incorrect in the Verifone Commander. Confirm the site’s service ID is entered
in by navigating to Help > Support in Configuration client to verify it is correct. If the service ID
entered is incorrect, contact the Verifone helpdesk to correct the service ID.

* Verifone Commander serial number may not match what the site has registered. Reach out to the
Verifone Helpdesk to correct the Verifone Commander Serial number and/or Service ID.

-
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ONE-TIME PASSWORD

The One-Time Password feature allows a one-time password (OTP) for a site’s Verifone Commander to be
sent to an email address. An OTP may be required to make changes to specific areas within Verifone
Configuration Client, such as Manage Users. However, the OTP is only displayed locally on the Verifone
Commander or Verifone POS.

Requirements
e Avalid account with Verifone C-Site Management
* An active site, onboarded with Verifone C-Site Management
* \Verifone Software Release 53.35+
* An active email associate with Verifone C-Site Management

* Manager access to Verifone Configuration Client.

Configuring OTP Emails

1. Log in to the Verifone C-Site Management application. In the top right corner of the application, select
your account profile icon and select OTP Settings.

My Account
OTF Settings

Terms

Help & Support

Logout

-
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2. If the Send OTP check box is not selected, click on Edit to enable the parameter. Save the changes if
they have been made.

QTP Settings

Send OTP <—

Email

customerdemo0712@gmail.com

NOTE
[jﬁ The email address cannot be changed as it is the User ID.

3. Login to Verifone Configuration Client and go to Security > Manage Users. Enter in the OTP when
prompted.

-
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4. Enter in the Verifone C-Site Management email address (the same one as used in the OTP settings) in
the User ID Field. Select Save on the User administration form.

User Administration

_> Save | Cancel

| @) Edits require a one-time password (OTP)

Configure Users

Add [ Delete
sraidie s Name | manager [ Disallow Login
KDS Employee | v
~|  Edit
Roles
. —Password Settings
Min. Length New Password | |
Max. Length [40 | Confirm Password | |
# of Days to Expire
Force change on next login  [] Password Guidelines
—Secure User Settings
Secure User ID |1 | Secure User Administration
.|| |~ \Verifone® C-Site Management

ULl [Your_email@email co | User ID Instructions |

@E NOTE As mentioned above in the Requirements section, Verifone Configuration Client users must
have a Verifone C-Site Management user ID to receive OTPs by email.

-
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Using the OTP to Email Feature

1. Any areas of Configuration Client that require an OTP will prompt for a One Time Password (as shown
below). Select Generate OTP to the right of the entry field. The OTP will be sent to the email configured.

One-Time Password

A One-Time Password (OTP) is required to access this function

One-Time Password ] Generate OTP <@—f—

Ok | | Cancel

Guidelines to generate an OTP

2. Check the email to retrieve the OTP and enter the prompt on Configuration Client.

no-replydEverifons. com QTR Genersbed

Subject OTP Generated
To: sample
Froam no-reply@verifone_com

Recened Thu Sep 23 2021 09:47:24 GMT-0400 (Eastern Daylight Time)
Sending IP. 54.240.4.15

Parts (ot | e

Attachments  [Suescioe o recame anacnmants|

_> OTP 3707 15 generated at 1127861 Mam street a1 2021-09-23 [3:47:2610

-
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[jﬁ NOTE

APPENDIX

Verifone Commander Release 53.41

Topic

Verifone
Commander
not
onboarded

When will
this appear

120 days
post
installation of
the Verifone
Commander
Software

verifone

Frequency

Appears at
login

Feature

Disablement e

N/A

NOT ONBOARDED

Proprietary + Confidential. © Verifone Inc. All rights reserved.

Self-checkout end users will not see prompting messages. Messages will only appear
when accessing cashier screens.

Resolution

Onboard the Verifone

A Commander

b o
v agres to
hle st

191



Verifone
Commander
Onboarded,
but ASM
Expired

Not
Connected

120 days
post
installation of
the Verifone
Commander
Software

Any time
after
Onboarding

verifone

Every
Transaction

When
connectivity
is lost to
C-Site.
Appears at
POS Login.

Verifone C-Site Management User Guide

N/A
ASM LICENSE HAS EXPIRED
tiane available at
htips: [ ieewwverifane.
0K
N/A

ainacted Lo
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Renew ASM License

1. Work with your
MNSP to confirm
connectivity to
Verifone C-Site is
maintained.

2. Contact the
helpdesk for
assistance.
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Verifone Commander Release 54.00 and 54.01

Topic

Verifone
Commander
not
onboarded

Verifone
Commander
Onboarded,
but ASM
Expired

When wiill
this appear

60 days post
installation of
the Verifone
Commander
Software

60 days post
installation of
the Verifone
Commander
Software

verifone

Frequenc FEEIITE

a y Disablement
Every Forecourt
transaction and POS

functionality

Disablement
occurs at 90
days for
Forecourt
and 91 days
for the POS.
Occurs at
midnight
when the
system is
idle.

Forecourt
and POS
functionality

Every
Transaction

Disablement
occurs at 90
days for
Forecourt
and 91 days
for the POS.
Occurs at
midnight
when the
system is
idle.

Messages

NOT ONBOARDED

Commander i
C-Sile Manag
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b 4

1o Werifone®
it

Resolution

Onboard the Verifone
Commander

Renew ASM License
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Not Anytime after N/A 1. Work with your
Connected Onboarding NOT CONNECTED MNSP to confirm
Commander is no longer connected o Connectivity tO
Verifone C-Site is
b enabled device for more . .
informaticn maintained.

2. Contact the
helpdesk for
assistance.

Verifone Commander Release 54.02

When wiill
this appear

Feature

Topic Disablement

Frequency Messages Resolution

Verifone
Commander
not
onboarded

60 days post  Every
installation of
the Verifone

Commander

transaction

Forecourt
and POS
functionality

Onboard the
Verifone
Commander

Software

Disablement
occurs at 90
days for
Payment
(inside), Self-
Checkout,
and

jch terms.

Forecourt.
POS is
disabled at 91
days. Occurs
at midnight
when the
system is
idle.

@
._I verifone
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Verifone
Commander
Onboarded,
but ASM
Expired

Not
Connected

60 days post
installation of
the Verifone
Commander
Software

Anytime after
Onboarding

verifone

Verifone C-Site Management User Guide

Every Forecourt Renew ASM
Transaction ~ and POS LICENSE HAS EXPIRED License
functionality
Disablement
occurs at 90
days for
Payment
(inside), Self-
Checkout,
and
Forecourt. EXPIRING IN 27 DAYS X
G Your Site Solution is expiring. Please visit
POS is https://www.verifone.com/sitesolution on
. a web enabled device to renew your license
disabled at 91 and subscription.
dayS. Occurs You must agree to the latest terms and
. conditions available at
at mldnlght https://www.verifone.com/cstore-terms as
h h part of the renewal process.
when the Your site functionality will be disabled on
system is 2023-09-26 11:59PM.
idle.
0K
N/A 1. Work with your
NOT CONNECTED X MNSP to confirm
Commander i no longer connected Lo ..
Verifone® -Site Management. connectivity to
i Verifone C-Site is
maintained.
2. Contact the
helpdesk for
assistance.
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Verifone

University Drive
Coral Springs,
FL 33065, USA

Fax: 4545 233
Phone: 001 454 2333

Thank you!

We are the payments architects who truly understand
commerce.

As payment architects we shape ecosystems for online and in-person
commerce experiences, including all the tools you need... from gateways
and acquiring to fraud management, tokenization, and reporting.

As commerce experts, we are here for you and your business. With our
payment devices, our systems & solutions and our support. Everywhere.
Anytime. So that your customers feel enabled, recognized and well taken
care of, even beyond their expectations.

Verifone. Creating omni-commerce solutions that simply shape powerful
customer experiences.
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